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EVALUATING THE PURCHASING CARD POLICY Georgia-

OVERVIEW

The purpose of the policy evaluation is to determine if the policy provides adequate
guidance to card program administrators, supervisors, cardholders, and other
employees affected by the purchasing card (e.g. employees for whom cardholders make
purchases).

The Policy Evaluation Checklist is an Excel spreadsheet that rates the policy as a high,
medium, or low risk that the policy does not provide adequate guidance. The rating is
based on the answers to questions about the policy. The answers can be “Yes”, “Needs
Improvement”, or “No”.

The evaluation checklist is available on-line at the State Purchasing Division (SPD) web
site under Process & Performance. The address is:

http://doas.ga.gov/StateLocal/SPD/Process/Pages/Home.aspx

- Folicy evaluation checklist in Excel format that rates a policy as
Policy Risk Evaluation a high, medium, or low risk that card program personnel do not 4/30/2010

have adequate quidance.

Click on the Excel icon to open the document. The version of the checklist on the web
site will always be the most current version that the Process Improvement Team from
the State Purchasing Division uses. However, Entities can modify the checklist to assign
different ratings to individual questions and to the score that results in a particular risk
rating. The number of possible points (all questions get a “Yes” answer) should always
be 100. In the SPD version of the spreadsheet, some questions receive four points and
others three for a “Yes” answer, depending on the importance SPD places on that
aspect of the policy. You might want to place more or less emphasis on some questions,
and that is acceptable. This tool is designed for you to evaluate your policy based on
your organization’s emphases.
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USING THE CHECKLIST

Go to the SPD web site and download the spreadsheet. It is recommended that you
save a master copy of the spreadsheet if you make any customizations.

Policy Evaluation Risk Level and Rating:

The blank spreadsheet will provide a place to enter your Entity’s name. The score will
display on the second line and will increase as more questions are answered either
“Yes” or “Needs Improvement”. Questions that are answered “No” will receive zero
points and the score will not change.

Column C of the spreadsheet has a drop-down list from which you select the proper
response to each question.

Does the Agency / University have a policy and
procedures manual governing how the program is to
be administered on the local level?

i Yes
2 Is the policy e_valuated for adequacy and relevance on owds Improvement el
a regular basis? Mo fom the

s date of the current policy withig R

Column D contains a formula that evaluates the response in Column C and assigns a
numerical value.

Column E provides a place to enter comments. Column F provides a place to enter the
page number where the topic of the question is covered.
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MODIFYING THE CHECKLIST
Advanced users of Excel who are familiar with the IF/Then statement concept can
modify the checklist to change the grading and rating functions.
The following areas can be modified:

¢ The number of points for a “Yes” or “Needs Improvement” answer. A “No” answer
should always receive zero points.

¢ The score needed to achieve a low, medium, or high-risk ranking.
e The score needed to achieve a grade of A, B, C, D, or F.
Modifying the Individual Question Point Values
The formula that assigns points is shown below:
book, click Edit Workbook, | Edit Workbook |
=IF{C6="Yes",3,IF{C6="Mao",0,IF{C6="Needs Improvement",1," "}}) ?

B c B

It uses an Excel IF formula. In this example:

e If the answer is “Yes”, the question receives three points

e If the answer is “No,” the question receives zero points

¢ If the answer is “Needs Improvement”, the question receives one point

To modify the formula, simply change the numbers. Remember, however, that the total
score must equal 100 points. If you add a point to the “Yes” answer, then you need to
either subtract one point from the score of “Needs Improvement” in the formula for
that cell or subtract one point from another question’s “Yes” or “Needs Improvement”
formula.

Modifying the Overall Points Grade and
Rating

chlist ij risk levels for scores
S~

The scores are maintained on the risk levels for
scores tab to the right of the Checklist tab.

The illustration to the right shows that a policy

that receives a score of 83 or above can be either L M —lL e
: : 79 78 B IMedium
an A ‘Or a B grade a.nd will bg a Low risk Iev.el, B 7or B IMedium
meaning that there is a low risk that the policy |s1 80 B Medium
does not provide adequate guidance. A policy |8/ 8 B Medum
. i 83 82 B ledium
that receives 82 would be a B score with a [a] oW
Medium risk level. 85 84 B |low
| 86 | 85 B Low
There are similar cutoffs for €, D, and F scores |8 :g i tgx
and for High risk. 88 A Low
A
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The VLOOKUP formula in cell E2 evaluates the score in cell D2 and assigns the risk level
for that score from the risk levels for scores tab. A similar VLOOKUP formula in cell F2
pulls the letter grade associated with the score from the risk levels for scores tab.

=VLOOKUP{D2,risk_level,3,FALSE) ) sy

Policy Evaluation Risk Level and Rating:

=VLOOKUP{D2,risk_level,2,FALSE)

B C
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EVALUATING CARD PROGRAM TRAINING Georgia-

OVERVIEW

The following checklist provides guidance to determine if an Entity conducts adequate
training for (1) personnel involved in program administration, (2) personnel responsible
for supervisory review of transactions, (3) cardholders, and (4) personnel responsible for
conducting the self-audit (internal audit). If any answers to the questions on the second
table below are “No” or “Needs Improvement”, make comments as to what the
deficiency is and how the area could be improved.

PROCUREMENT TRAINING INFORMATION
In the table below, indicate the training the following personnel have had as it relates to
the purchasing card program based on the following key:
¢ | =Introduction to Purchasing Card Principles (yes/no in drop-down list)
¢ SA = How to Conduct a Self-Audit (P-card) (yes/no in drop-down list)

e Other = Indicate any other procurement training

Position How Long?

APO / UPO

Program Administrator

Program Coordinator

Program Coordinator

Program Coordinator

Program Coordinator

Program Coordinator

Program Coordinator
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CARDHOLDER AND SUPERVISOR TRAINING CRITERIA

Training Need

Yes / No / Needs

Improvement

Have any other Procurement personnel attended the
Introduction to Purchasing Card Principles training? If

so, attach an additional sheet showing names and titles.

Have any other Procurement personnel attended the
How to Conduct a Self-Audit (P-card) training? If so,
attach an additional sheet showing names and titles.

Have any cardholders attended the Introduction to
Purchasing Card Principles training?

Have any cardholders’ supervisors attended the

Introduction to Purchasing Card Principles training? ] ] ]
Does management communicate changes in State or
Entity policies and procedures to cardholders and ] ] ]

supervisors? If so, how is this done?

Does the Entity require cardholders and supervisors to
attend training prior to issuance of the card?

How is this training conducted (select one):

e Group (class)
¢ One-on-one
e On-line tutorial

e Other (explain)

Explain “Other” method of training:

Does the Entity offer refresher training at least
annually?

Page |6




P-Card Audit Guide

Yes / No / Needs

Training Need
Improvement

10. Does management maintain records of who has
attended training, including refresher training? [l [l [l

11. Are the following areas covered in the training
materials?

e Allowed purchases

e Prohibited purchases

e Spending limits, including STL and cycle

e How to complete the transaction log or approved
alternative

e Tax-exemption certificates and procedures

e How to review monthly billing statement

e Cardholder responsibilities, including formal
cardholder agreement

O oo 0o jgjot
O oo 0o jgjot
O oo 0o jgjot

12. What materials does management provide to
cardholders and supervisors during training for them to
keep as references? Check all that apply:

|:| State Purchasing Card Policy

[ ] Agency/Institution Policy

e [ ] written procedures (describe):

o |:| Supply of Sales and Use Tax Exemption certificates
[ ] other (describe):

13. Does the Entity require cardholders to demonstrate an
adequate knowledge of State and Entity policy prior to ] ] ]
issuance of the card (e.g. written test)?

14. Does the Entity require supervisors to demonstrate an
adequate knowledge of State and Entity policy prior to
providing supervisory review of transactions (e.g. [l [l [l
written test)?
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EVALUATING SPENDING LIMITS Georgia-

The goal in evaluating cardholder spending limits is to determine if the profile groups
you have established provide the cardholders with the credit limits needed to do their
job without exposing your Entity to unnecessary risk. (By assigning cardholders to
profile groups, you can assign the same spending limits to multiple cardholders without
manually setting the same limits for each cardholder individually.)

There are two required spending limits: (1) the Single Transaction Limit (STL) and (2) the
cycle limit, also known as the “credit limit”. State Purchasing Division (SPD) does not
dictate the number of profiles an Entity can establish. Except for the Single Transaction
Limit of less than $5,000 ($4,999.99 or less) and cycle limit $25,000, SPD does not
dictate the spending limits an Entity can impose on cardholders. Card Program
Administrators also do not have to obtain any approvals from SPD to raise cardholder
spending limits if the amount will still be within these limits. Bank of America also
provides an optional limit. An Entity can also choose to limit the number of transactions
a cardholder can make in one day.

PROFILE “BEST PRACTICES”

Limit the Number of Profiles

Basing profiles on job titles and actual spend levels permits an Entity to limit the number
of profiles it must maintain. For example, an Entity can group job titles with similar
spending habits into one profile. When an employee receives a purchasing card, the
Card Program Administrator can assign the cardholder to the profile for the employee’s
job title. For individual cardholders whose spend does not fit the profile, or who have
unusual situations, management can make exceptions to the rule that the cardholder
must be in a specific profile.

Base Profiles on Job Titles

Develop profiles based on job titles. Generally, employees with the same or similar job
titles will need the same spending limits. Assign a cycle limit that will accommodate the
cardholder(s) in that group with the largest spend.

Calculate:

¢ The average cycle spend for a 12-month period as well as the largest cycle amount
for each cardholder.

¢ The average cycle spend and largest cycle amount for the same period for all job
titles. For example, determine the average spend for all Clerk Il personnel,
Procurement Officer | personnel, etc.
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e Compare the average cycle spend and largest cycle spend for individual cardholders

with the average spend by cardholders with the same job title.

Determine if the calculations look reasonable for the type of job each cardholder has. A
large volume of spend on a non-procurement job title might indicate that the
cardholder has job responsibilities not normally associated with the title. A small
volume of spend on a procurement job title might indicate that the employee is not
using the card to its full potential or that the employee fulfills non-procurement related

job duties.

The chart below shows an example of a system of standard profiles plus a special-

purpose profile, explained below.

Profile Cycle Limit Traii:ag::ion TrZ:is!‘al::izfns MCC Groups

1 $1,000 $300 5 1,2

2 $1,500 $750 5 1,2,3

3 $3,500 $1,000 8 1,2,3

4 $3,500 $1,000 3 1,2

5 $5,000 $1,000 10 2,3

6 $10,000 $2,500 15 1,2,3

7 $10,000 $2,500 10 2,3

8 $25,000 $5,000 No Limit 1,2,3

9 $40,000 $5,000 No Limit 1,2,3
Special 1 $100,000 $10,000 No Limit 1,2,3,4

Merchant Category Code Groups (MCCG):

e GASTATE

e GASTATE1

e GASTATE2

o GAATHTRAV

As shown, management can structure the card profiles so that cardholders can make
transactions only at merchants assigned to specific merchant category code groups. The
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State of Georgia currently has four groups, three that are available to all cardholders
and a travel group that can be used on a limited or temporary basis.

Assign job titles to a profile based on actual, historical spend information or potential
spend for that type of job. For example, the Card Program Administrator could assign all
procurement personnel to Profile #7 because they will need more flexibility than an
Administrative Assistant who orders office supplies for one unit. The Card Program
Administrator could assign the Administrative Assistant to a profile with more
restrictions, such as Profile #2.

Management must address each case individually because there can be many reasons
for spend not in keeping with a job title. Profile procedures should address what to do if
an individual cardholder needs larger cycle or single transaction limits than those for the
job title. A move up to the next profile might be in order.

Use Special Purpose Profiles

Each Entity will determine the number of standard profiles it needs based on job
requirements and actual spend. Some agencies, such as GEMA, DNR, and DOT, could
have emergencies or other special situations arise where cardholders need more
flexibility in the types and amounts of purchases they can make. The Card Program
Administrator can move cardholders from the standard profile to the emergency profile
and then back to the standard profile when the emergency is over.

For example, certain agencies, such as GEMA and DOT, must respond to either natural
or man-made disasters anywhere in the State. In these situations, cardholders might
need more flexibility in how much they can spend and where they can use the cards.
The DOT might send road crews from South Georgia to North Georgia to assist when
there is a major winter event. Road crew foremen might need to pay for lodging and
meals for the South Georgia crews. Once the emergency is over, the Card Program
Administrator can move the cardholders back to the standard profile.

Data Analysis for Profile Evaluation

In order to perform a spend analysis on profiles, the Card Program Administrator needs
the following information for at least 12 cycles. It is highly recommended that you
evaluate your profiles annually for the first three years of your program and at least
every 18 months thereafter.

You can use either Microsoft Excel or Microsoft Access to work with the data.
Transaction data and profile information are available through Works Payment
Manager.

e Cardholder name

e Cardholder job title (not in Works Payment Manager)
e Current spending limits

¢ Single Transaction (STL)

e Cycle

e # of transactions per day

¢ Individual transaction dollar amounts
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¢ Individual transaction post date

The following list of analysis techniques can help you analyze your data to determine
appropriate single transaction and cycle limits. Number of transactions per day is up to
the discretion of management.

e Compare individual cardholder average cycle spend to the cycle spend for the profile.

¢+ If the cardholder consistently reaches the cycle limit and needs temporary
increases, this might be justification for moving the cardholder to the next
higher profile. It could also mean that the cardholder performs actual job
responsibilities not in keeping with the job title.

¢+ If a cardholder consistently uses a lower percentage of the cycle limit, this
might indicate that the limit is too high or that the cardholder is not using
the card when possible.

e Calculate total spend by cardholder. Use the sort feature in Excel to sort these by job
title and by amount. Evaluate the types of job titles found in each natural grouping.

¢+ Do job titles appear in more than one group?

¢ Are all cardholders with the same or similar job titles found in the same
natural group?

¢ Sort the data by job title and then by total spend. Determine the maximum
transaction amount and maximum cycle amount within each job title. These
figures can provide insight into appropriate limits for the profile that will
include that job title.

e Compare individual cardholder’s maximum and average transaction amount and
maximum and average cycle spend to the assigned profile.

¢+ Does the cardholder consistently reach the STL or cycle limit?

¢+ Does the cardholder consistently fall significantly short of the STL or cycle
limit for the profile?

¢+ Determine the cardholder with the highest cycle spend within each job title.
This figure might be an indication of a good cycle limit for the job title.

e Determine if cardholders within a job title have similar spending habits. If thereis a
cardholder who has significantly more spend than cardholders in the same job title,
this cardholder might be a candidate for an exception to the standard profile. Other
cardholders could remain in the lower spending limit profile.
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PROCEDURE FOR SPENDING LIMITS ANALYSIS

The Spending Limits Analysis is designed to help you answer the question, “Could we
reduce our risk of loss due to abuse while still providing our cardholders with the
spending capacity they need in order to do their jobs?”

This chapters provides guidance on what to look for in a spending limits analysis as well
as how to do this using basic Excel skills. For advanced Excel users, the chapter also
explains how to create the analysis pivot tables from scratch as well as how to use a pre-
designed template available from the State Purchasing Division’s Process Improvement
Team.

It is highly recommended that you read these instructions through completely prior to
beginning an analysis in order to ensure that you know where you are going with it.

Refer to the Chapter on Evaluating Spending Limits for suggestions for your analysis.

GETTING STARTED
Download the following fields to a comma-delimited text file from Works Payment
Manager using a custom report.
e Cardholder User Name
¢ Last Four Digits (of the card number)
e Amount
e Purchase Date
e Post Date
e Merchant/Vendor Name
¢ Merchant City
e Merchant State
e MCC
e MCC Description
e Card Profile Name
e Group Name (cardholder group name)

e Credit Limit
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¢ Single Transaction Limit

Open the text file in Excel. Designate all fields except the following as “text” data type.
By keeping the “General” data type, the amount will be a number (not currency,
though) and the dates will display as dates.

¢ Amount
® Purchase Date
e Post Date

Load all transactions into a new Excel workbook. (NOTE: lllustrations in this document
are from Excel 2007. If using 2003, the user will have to follow steps for that version to
place the fields.)

BAsIc EXCEL SKILLS

Basic Cycle Limit Evaluation

Once the transaction data has been downloaded into an Excel spreadsheet, sort the
spreadsheet by cardholder name in either ascending or descending order and then by
transaction amount in ascending or descending order.

Insert two rows between each cardholder section. Use the SUM function to determine
the total spend for the cycle. Compare this to the cardholder’s cycle limit.

Basic Single Transaction Limit Evaluation

Once the transaction data has been downloaded into an Excel spreadsheet, sort the
spreadsheet by cardholder name in either ascending or descending order and then by
transaction amount in descending order. Scroll through the cardholders and compare
the largest transaction amount to the Single Transaction Limit.

CYCLE LIMIT ANALYSIS WITH PIE CHART (ADVANCED EXCEL)

Construct first pivot table - Cycle Limit Analysis

Create a pivot table with the following configuration:

O MCC Description J
=

M ard Drafile Bam

e Row Labels

Drag fields between arsas below:

¢+ Ca rd hOIder name ¥ Report Filter 4 Column Labels
¢ Ca rd # Cydle End i
¢+ Cycle Limit

¢+ Status

1] Row Labels X Values

CH User Name ¥ Sum of Amount ¥
Credit Limit ~
Single Txn Limit *

[] Defer Layout Update
g ()

¢ Column Labels — Cycle Ending Date

¢ Values — Sum of transaction amount
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Calculated Columns

On the same line as the column headings (row four of the spreadsheet), label the six
columns to the right of the data with the names shown in a-f below. Put the formulas
below in each column on the first row beneath the column names (fifth row of the
spreadsheet). Once all formulas are entered on the first row, copy them down for all
rows:

# of Positive Cycles - This step will calculate the number of cycles during which a
cardholder had net positive activity.

¢+ The formula for positive spend is: =COUNTIF(range, “>0"). “Range” is all of
the cycle ending columns, excluding Grand Total, for the row. For example, if
the cycle ending columns are column D through column O and the Grand
Total is shown in column P, then the range for the first row will be D5:P5.
The formula would read =COUNTIF(D5:P5, “>0").

e # of Negative Cycles - This step will calculate the number of cycles during which the
cardholder had a net credit (negative) amount:

¢+ The formula for negative spend is: =COUNTIF(range, “<0”). “Range” is all of
the cycle ending columns, excluding Grand Total, for the row.

¢ For example, if the cycle ending columns are column D through column O
and the Grand Total is shown in column P, then the range for the first row
will be D5:P5. The formula would read =COUNTIF(D5:P5, “<0”).

e # of Active Cycles

¢+ Add the number of negative and positive spend cycles to determine the total
number of cycles during which the cardholder had activity.

¢+ The formula for the total number of cycles is =Q5+R5, assuming that the
number of positive and negative cycles are in columns R and S, respectively.

¢ Total Cycle Limit: Cycle Limit times # of active cycles.

¢+ The cardholder could have spent this amount for all cycles during which
there was activity on the card. The formula is # of Active Cycles times the
cardholder’s credit limit.

¢+ For example, assume the cardholder’s cycle limit is in cell B5, and the
number of active cycles, created in step a.iii, is in cell, the S5 formula would
read =B5*S5.

e Average Cycle Spend

¢+ Total Cycle Spend (Grand Total column) divided by # of Active Cycles (from
#3 above)

¢ For example, if Total Cycle Limit is in cell T5 and the # of Active Cycles is in
cell S5, the formula would read =T5/S5.

e % of Cycle

¢ Format the column as percentage with two decimal places. This is average
cycle spend as a percentage of a single cycle limit.
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For example, assume the average cycle spend, created in the previous step, is in cell US
and the single cycle limit is in cell €5, the formula would read =U5/C5.

The formulas and results should look like this:

# of Positive Cycles # of Megative Cycles # of Active Cycles Total Cycle Limit Avg Cycle Spend % of Cycle /
=COUNTIF{DS5:P3, ">0") =COUNTIF{D3:P3, "<0") =0Q5+R3 =55"B4 =Pa/34 =Ja/B5
=COUNTIF(D6:P8, "=>0") =COUNTIF(D6:P8, "<0") =06+RE =56"B6 =P6/S6 =U6B/B6
=COUNTIF(D7:P7, ">0") =COUNTIF(D7:P7, "<0") =Q7+R7 =87*B7 =P7/ST =UT/B7
"=0") =COUNTIF(D8:P8, "<0") =08+R8 =58*B3 =P8/58 =Us/Ba
=COUNTIF(D9:PS, "<0")  =Q9+R3 =U9/B9

# of Positive Cycles #of Megative Cycles  # of Active Cycles Total Cycle Limit | Avg Cycle Spend % of Cycle
0 5 10.000.00 & 4012 0.30%
0 5 5.000.00 % 31412 165.71%
0 5 3.000.00 % 314.38 31.44%
0 5 2500000 5 74913 14.958%
0 5 15.000.00 5 112.30 2.25%
0 5 10.000.00 5 15.28 0.31%
0 5 90.000.00 § 434210 43.42%
0 3.328.37 33.28%

Preparing a Pie Chart

If desired, you can create a chart or graph to illustrate Cycle Limit and Single Transaction
Limit (discussed below) utilization.

¢ Name the column range for the % of Cycle as
percycle.

— L=

Function Libra .
¢ Hi-lite the entire column and enter percycle in the -y -
cell address field in the top left-hand corner as ? o - = =
shown in the diagram to the right. N y
¢+ Enter the text and formulas in any three \J
columns to the right. Column letters and row numbers are shown for
illustration purposes only. You columns and rows might be different and you

will need to use your column letters and row numbers instead of these if
they are different. Note that:

¢ The numbers shown in the formulas in Column AC have decimal points. They must
be put in exactly as shown.

z -2 £
AA I AB I AC I AD_ |

¢ The greater than/less than symbols
and the number must be enclosed in
qguotation marks.

#of Cards in Range in
column AC

<1% =ACS =COUNTIF(percycle,"<.01")
1% - 10% =AC6-ABS =COUNTIF(percycle,"<.1")
10% - 20% =ACT7-ACE =COUNTIF(percycle,"<.2")
20% - 50% =ACE-ACT =COUNTIF(percycle,"<.5")
2= 50% =ACS =COUNTIF(percycle,">5")

‘: =i -
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The results will appear as shown in the diagram

to the right. = B o Ak
Create the graph or chart using the data shown in |11
the orange box to show the number of cards in %
each range and the percentage of the total #of Cards
number of cards for each range. See next page | 4 in Range
for a three-dimensional pie chart example. 5 f<1% 2 2
B 1% - 10% 23 25
7M10% - 20% 13 38
8M20% - 50% 15 53
gl>=50% 3 3
y
Cycle Limit Utilization
8;13% m 2;3%
m<1%

H 15; 25% ® 23;38%

0 13;21%

m1%-10%

1 10% - 20%

W 20% - 50%
>=50%

Analysis Thoughts

There are no industry benchmarks, so it is up to management to determine the level of
risk that they are comfortable with. As you can see from this illustration, only 13% of
cardholders had an average cycle spend of more than 50% of their cycle limit.
largest percentage of cardholders averaged between 1% and 10% of their cycle. From
these figures, it appears that cycle limits for this Entity’s cardholders are set higher than
what they need. Cardholders who consistently use a high percentage of their cycle limit
are probably set at realistic levels. Those who consistently use less than 50% of their
cycle limit could be set too high for their needs. However, if these cardholders are also
buyers who create purchase orders, they could be encouraged to use the purchasing

card in lieu of purchase orders in order to increase efficiency.

The

Page |17



P-Card Audit Guide

Alternate Cycle Limit Review

The Cycle Limit should also be able to handle the largest per cycle spend for each
cardholder. To determine if cardholders are using the purchasing card to the greatest
extent needed, instead of the number of cycles with activity (a-c above), enter the
formula =MAX(range) in the column next to the Grand Total. “Range” is all of the cycle
ending columns, excluding Grand Total, for the row. The columns will show the amount
of spend in each cycle. The Grand Total column will show the largest cycle amount for
the time period for the cardholder.

Once again, there are no industry benchmarks. However, doing this analysis, paying
special attention to cardholders who also create purchase orders, will identify areas
where cardholders have the capacity to transfer purchase order spend to the purchasing
card in order to increase purchasing efficiency. Refer to the self-audit tool Evaluating
Vendor Spend for suggestions on incorporating purchase order spend and purchasing
card spend into one analysis.

SINGLE TRANSACTION LIMIT (STL) ANALYSIS WITH PIE CHART (ADVANCED EXCEL)

The Single Transaction Limit Analysis should be done using two different calculations on
the transaction amount field. The instructions below use the “average transaction
amount” to compare to Single Transaction Limits. However, since the STL also needs to
accommodate the highest transaction amount in a given time period, the analysis
should be done using the highest transaction amount.

Construct second pivot table - Single Transaction Limit Analysis
* Row Labels

¢ Cardholder name
¢ Card#
¢ Single Transaction Limit

e Column Labels — None

¢ Values — Largest (Max) of transaction amount. This will display the largest
transaction amount

Calculate the average transaction amount as a percent of the Single Transaction Limit.
See illustration below.

On row four of the spreadsheet with the pivot table, label the column to the right of the
Grand Total as % of STL.

1. Format the column as percentage with two decimal places.

¢ Enter a formula on the next row in the same column as the largest
transaction amount divided by the Single Transaction Limit. For example, if
the average transaction amount created in the previous step is in cell C5 and
the STL is in cell BS, the formula would read =C5/BS5.

2. Name the column range with the percentages as perstl.
3. Enter the following text and formulas in any three columns to the right of the %
of STL column. Column letters and row numbers are shown for illustration
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purposes only. Your columns and rows might be different and you will need to
use your column letters and row numbers instead of these if they are different.

Note that:

¢+ The numbers shown in the formula have decimal points. They must be put in
exactly as shown.
¢+ The greater than/less than symbols and the number must be enclosed in
qguotation marks as shown.

I Funchie

Max

Single Txn Limit

5000

4000

5000

10000

| ggmmetsz

2

perstl

<1%

1% - 10%
10% - 20%
20% - 50%
»=50%

#of Cards in
Range in
column AC
=G3

=G4-F3
=G5-G4
=G6-G5

=G7

3]

=COUNTIF{perstl
=COUNTIF{perstl
=COUNTIF(perstl
=COUNTIF{perstl
=COUNTIF{perstl

"<.01")
'<.1)
<)
Ry
125"

SPENDING LIMITS ANALYSIS USING THE TEMPLATE (BASIC /INTERMEDIATE EXCEL)

If you want review individual cardholders quickly, or if you are not comfortable with
Excel pivot tables, the Process Improvement team has developed an Excel template to
calculate Total Spend and Average Transaction Amount to compare to Cycle Limit and
Single Transaction Limit, respectively. You will need the following data elements (in the
order on the spreadsheet) from Works Payment Manager.

¢ Program Card Name (This column is not essential. However, the template has a
column for it. If you do not download, or enter, your card program name, then you

will need to delete column B from the Data tab.)

¢ Cardholder’s Group Name

e Cardholder name

¢ Last four digits of the card number

e Transaction amount
e Purchase date

e Post date

e Merchant name

e Supplier city

e Supplier state

e MCC

e MCC description

e Card Profile Name
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e Credit (cycle) Limit
¢ Single Transaction Limit

The Read Me tab of the workbook contains instructions on how/where to enter the data
and how to refresh the pivot table.

The columns on the Data tab of the workbook are named according to the above list of
data elements on the second row of the spreadsheet.

e The first row of the spreadsheet has a drop-down list in cell Al for you to select the
day of the month on which your cycle ends (4 or 15 or 27). These are the only values
that the cell will accept.

e There is also a note instructing you not to delete rows one or two.

¢ Note thatin cell A3, there is already a date value of 01-15-1900. This field has a
formula that you will copy to all data rows during the analysis. Do not delete this
formula. However, if you do accidentally delete it, here it is:

=(IF(DAY(H3)<=$A%1, MONTH(H3),IF(MONTH(H3)=12,1, MONTH(H3)+1)) &"-"& $AS$1

The Pivot Table tab of the workbook has the pivot table that you will use to review
cardholder actual spend and spending limits. Once the data is copied onto the Data tab,
you will “refresh” the pivot table. In Excel 2003, select Data—>Refresh Data from the
menu bar. In Excel 2007, click on the Data tab and click Refresh All.

The pivot table will do more than one calculation on the transaction amount only if
there are three or fewer row fields. If you are not interested in the card number for
your analysis, you can leave it off the pivot table. If you leave it off, you can display both
the Cycle Limit and the Single Transaction Limit at the same time. However, if you want
to see it for the either analysis, you will need to have just the Cycle Limit field as a row
or just the STL field as a row.

To load the transaction data into the spreadsheet:

e Open the Works Payment Manager download file as described above
¢ Click anywhere in the download spreadsheet

¢ Click CTRL-A to highlight all data

¢ Click CTRL-C to copy all data to the Windows clipboard

¢ Click on Cell B3 on the Data spreadsheet

¢ Click CTRL-V to paste the data into the Data tab spreadsheet
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EVALUATING VENDOR SPEND LEVELS G( I T
eorgia

State purchasing regulations as found in the Official Code of Georgia, Annotated, require
competitive bids for any purchases anticipated to be $5,000 or more. The $5,000
competitive bid requirement is based on “purchase(s)” and is interpreted as the total of
a single purchase, either purchase order or purchasing card transaction or combination
of both. A “single purchase” is defined as any purchase of like or similar items where
the need is foreseeable or known at the time of the purchase. Using the purchasing
card as a method of payment does not relieve the State Entity, or cardholders, from
following competitive bidding procedures when foreseeable and/or known purchases
are determined to be $5,000 or more. Refer to the Georgia Procurement Manual for
additional information.

The APO/CUPO is responsible for including purchasing card transactions in the quarterly
spend evaluation required by the Georgia Procurement Manual. This exercise explained
below allows the user to:

¢ Quickly identify vendors with more than $5,000 in transactions for any one day,
regardless of the number of cardholders, in order to determine if cardholders are
splitting purchases to circumvent bid requirements.

e Assist in the quarterly vendor spend analysis to identify areas where State Entity
contracts could result in cost savings.

COMPILING TRANSACTION DATA

Works Payment Manager allows the user to download transaction information into an
Excel spreadsheet. However, if the user expects that there will be more than 65,535
rows, the transactions must be downloaded to a text file and then opened with Excel.

The following data fields should be exported using a custom report. If analyzing for the
same time period as the Spending Limits Analysis, you can use that export and/or the
spreadsheet used for that analysis. It is recommended that you use at least three cycles
(one quarter) of spend for the vendor spend analysis.

e Cardholder user name
e Post (Bank) Date

® Purchase Date

e Merchant Name

e Merchant City

¢ Transaction Amount
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Transaction MCC

MCC Description

Copy the appropriate data to the corresponding columns on the “Spending Limits
Analysis Template.xls” used for the cardholder spending limits analysis.

Use this spreadsheet because you will need it to calculate the cycle ending date. There
is a column with a built-in formula for calculating the cycle end date based on the bank
posting date and when your Entity’s cycle ends.

There is a “Read Me” tab on the spreadsheet with general instructions.

BAsIc EXCEL SKILLS

Once the transaction data is downloaded from Works Payment Manager into an Excel
spreadsheet, sort the spreadsheet by vendor name and transaction date. Review each
vendor individually to determine if:

Any single transaction or combination of transactions in a single day exceeded
$5,000. This could indicate split transactions.

Insert two rows beneath each vendor name in order to facilitate calculating total
spend for the time period.

¢ Use the SUM function in the transaction amount column to determine what
was spent by all cardholders with each vendor during the period.

¢+ Ask: Would a State Entity contract be beneficial? Does another State Entity
have a contract for these goods or services that we could piggyback from?

Pull purchase order information from the financial system (see below) and include
these amounts for those vendors where there is both purchasing card and purchase
order spend.

For advanced Excel users, see the following pages on use of a pivot table to facilitate the
review.

Page |22



P-Card Audit Guide

CYCLE SPEND ANALYSIS - PIvoT TABLE (ADVANCED EXCEL)

Use of a pivot table will make analyzing vendor spend much quicker since you will be
able to display a list of vendor names and the total spend for each one without having to
insert rows and use the SUM function. Refer to the Appendices for pivot tables in Excel
2003 and Excel 2007 for step-by-step instructions on creating a pivot table.

Once data has been copied to the template, ensure that the Data Source for the pivot
table includes all rows on the Data tab.

Configure the pivot table to have the following layout
e Row —Vendor name

e Column — Cycle ending date

e Data—Sum of transaction amount

Analysis

¢+ Review the pivot table for vendors with unusual trends in dollar amounts.

¢+ Review the merchant names for suspicious merchants.

¢+ Double-click on the dollar amount to copy these transactions to a new
spreadsheet. Rename the spreadsheet to the vendor name.

¢ Obtain and review the documentation for the transactions.

Split Transactions Analysis

Once data has been copied to the template, ensure that the Data Source for the pivot
table includes all rows on the Data tab.

Configure the pivot table to have the following layout

e Row —Vendor name

e Column —Purchase Date

e Data—Sum of transaction amount

Analysis

On the pivot table, replace the Cycle End column with the Purchase Date.

If any vendors have more than $5,000 in a single day, determine if these transactions
were:

e From a contract, either SWC or State Entity or
¢ The result of a competitive bid process.

e |If there are any single transactions >= $5,000 at a non-contract vendor, determine if
these purchases were bid.

e Obtain and review the documentation to determine the circumstances.

¢ Ensure that appropriate documentation is retained if it was an emergency purchase
and that the Emergency Authorization was sent to the State Purchasing Division.
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FINANCIAL SYSTEM PURCHASES (BASIC EXCEL)
Run the financial system query that will provide the data shown below to Excel. Name
the spreadsheet Vendor PO Analysis. See analysis steps below.

Run the PeopleSoft query OPO019D_PO_LIST BY_BU_DETAIL (State Accounting Office
PeopleSoft users) or equivalent query in non-SAO PeopleSoft or non-PeopleSoft
financial systems that shows the following information. Items in red font are required,
the other items are the ones that come in the standard 19D query. You can delete
those columns once you download the query to Excel, if desired.

e Unit (Agency code)

e Origin

e PO Number

e Change Order

e PO Date

e Type

* PO Reference

e Status

e Budget Status

¢ Vendor (this field is the 10-digit vendor ID)
¢ Name (vendor name)

e Vendor Classification

e Payment Terms

¢ Buyer-Phone

e Line#

* 5 Digit NIGP

10 Digit NIGP

e Description

¢ Line Amount

¢ Build a pivot table with the following layout:
* Rows

¢ Name (vendor name)

e Buyer-Phone

e Data — Sum of Line Amount (format as currency)
Analysis

e Using the filter box on the Buyer-Phone field, select all of the buyers who are also
cardholders.
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e Review for vendors that also accept the P-card.
¢ Focus on vendors shown on the listing of Statewide Contracts and Agency contracts.

Make a list of the purchase orders:
Buyer name

Vendor name

PO number

PO date

Total dollar amount

* & & o o o

e Determine if P-card spending limits, both Single Transaction and Cycle Limit, for the
buyers could have accommodated using the P-card instead of a purchase order for
the purchases.

e Determine if other non-cardholder buyers are using vendors that accept the
purchasing card.

¢ Evaluate to determine if it would be beneficial to issue purchasing cards to these
buyers.

¢ Encourage buyers with cards to use the card instead of a purchase order for all
vendors that accept cards.
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P-CARD COMPLIANCE ANALYSIS WORKBOOK G(l P
eorgia
(ADVANCED EXCEL)
OVERVIEW

The State of Georgia Purchasing Card (P-Card) is a procurement tool in the same way
that a purchase order is a procurement tool. All legal requirements for procurement in
the State of Georgia, as found in the Official Code of Georgia, Annotated (0.C.G.A.) and
the Georgia Procurement Manual (GPM), govern use of the P-Card. Training provided to
cardholders and supervisors or approving officials prior to receiving cards or supervising
a cardholder must include guidance on these laws and administrative rules. Card
Program Administrators, Auditors, and other third-party reviewers must include
compliance with these laws and administrative rules in their audit processes. If
cardholders are not abiding by the requirements, then additional training and/or
corrective action will be necessary.

P-Card industry best practices state that it is not necessary to audit every transaction.
This should be done at the supervisory level. The auditor’s role is to evaluate the
controls in place and to review an adequate sample of transactions to determine with
reasonable certainty that controls are working and that the card is being used according
to State and internal policy requirements. A review method known as “continuous
monitoring” is also becoming widely recommended and practiced.

Continuous Monitoring allows you to identify transactions where cardholders are not
abiding by either State regulations or your own internal policies and procedures. In
Microsoft Excel, “VLOOKUP” formulas can look at specific fields in a transaction to
determine if they comply with a set of pre-established business rules for that particular
data element, such as the vendor name or the Merchant Category Code (MCC). Those
that pass the test can be eliminated from a high-level review. Those transactions that
do not pass are the ones that you can focus your attention on to determine if your State
Entity is at risk for financial loss due to such things as failure to bid large purchases or
failure to use established contracts.

The P-Card Compliance Analysis Workbook is an Excel workbook designed to help the
Card Program Administrator or auditor monitor P-Card transactions without actually
looking at each one. The workbook can be used with transaction data over any period
of time, even on a weekly basis if resources permit. Use of this workbook is optional.

The P-Card Compliance Analysis Workbook uses formulas in one cell to compare the
values in another cell on the row to a list of a values. It provides a “Yes” or a “No”
response to indicate that the value in the cell matches or does not match the criteria.
This can eliminate transactions that, for any number of reasons, do not need to be
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included in a high-level audit. (This is not to say that these transactions should never be
reviewed, though. When doing an audit, a sample should be chosen from the total
population in order to get an adequate picture.) The criteria used in this workbook are
based on the Georgia Procurement Manual and the State P-Card Policy. The workbook
can be customized to incorporate unique State Entity business rules, as well.

This workbook makes extensive use of lookup formulas, pivot tables, and filters. Users
should have intermediate to advanced skills in Excel or access to helpful resources, such
as reference books and other users. If the user needs help in this area, the Process
Improvement Team has also provided a brief overview on how to use pivot tables on
the State Purchasing Division web site.

DOWNLOADING TRANSACTIONS FROM WORKS PAYMENT MANAGER

The workbook is a template with pre-established columns based on a specific Works
Payment Manager download file layout. The data can be downloaded from Works
either to an Excel file or to a text file. However, the download for this workbook must
be a text file because some fields that the workbook needs as “text” come out of Works
in a numeric format. Numeric fields will not work with the VLOOKUP formulas on the
spreadsheet.

If you download the transactions to a text file, you can specify that the Merchant
Category Code can be a text field instead of a numeric field when you open the file.
There are two reasons for this:

e There are some MCC's that have leading zeroes. If opened directly in Excel, Excel will
assume that the field should be numeric. The leading zeroes will be removed. The
MCC “0742"”, for example, would display in Excel as “742".

¢ The MCC field is used in VLOOKUP formulas. The formula will only work if the field is
a text field. It will not work with numeric fields.

You can download the transactions for any time period. However, it is recommended
that you download based on your cycle end date. For example, if your cycle ends on the
15™ of the month, you would want to download from the 14" of one month to the 15"
of the next month. This will enable you to more accurately determine if cardholder
cycle limit levels are set appropriately for the cardholders’ needs.

It is recommended that you configure and “bookmark” a report in Works Payment
Manager so that the report does not have to be re-created each time. Open either the
Billing Statement or the Spend by MCC report to get started. Add, delete, and re-
arrange fields as needed. For assistance with configuring a report in Works Payment
Manager, click on the Tools link on the left-hand side menu and select Training.
Navigate to the Quick Reference Guide entitled “Creating Configurable Reports”. Refer
to the chapter Configurable Reports in Works Payment Manager for additional
information.

File Layout

The workbook uses the following data fields. The fields in red font are required. If any
of the others are not downloaded from Works, the user must remove those columns
from the spreadsheet prior to using. If you add any fields from Works Payment
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Manager, then a corresponding column must be inserted into the appropriate place on
the Data tab of the workbook. The corresponding column letters are shown next to the
field name in the list below.

The layout in Works Payment Manager is shown below and in the screen shots to the
right. Refer to the section in this document entitled Configurable Reports in Works
Payment Manager for more details on how to run configurable reports.

e CH User Name
e last 4 Digits
e Amount

e Purchase Date

¢ Post Date N
CH User Mame -
Last 4 Digi
e Comp Supp Name ot ﬂ
Purchase Date -
Post Date
e Comp Supp Street 1 Com Suop e x
comp Supp City dt |
1 omp Su 3
e Comp Supp City Come e 22
Comp Supp Phone |
MCC hd
e Comp Supp State Ca Supp Pore |
MCC Description Edit |

Grp Group MName
Single Tan Limit
Credit Limit
‘Wendor Name

e Comp Supp Zip

e Comp Supp Phone
e MCC

e MCC Description
e Grp Group Name
¢ Single Txn Limit

e Credit Limit

Under “Transaction Type”, ensure that |[TransactionType: x| [¢ Cazh advance
“Reimbursement” and “Payment” are not W misc Cradit

¥ Misc Debit
checked.

w Purchase

Reimbursemen
Payment

s
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Exporting to Excel

If you know that you have fewer than
65,535 rows, then you can export the
transactions from Works directly into
Excel. You can then skip to the section
entitled “Copy Transaction Data to the
P-Card Compliance Workbook” below.

Exporting to a Text File

If you know that you will have more
than 65,535 rows, then you will need
to export the data to a text file and
then open with Excel. Excel 2003,
though, will only handle 65,535 rows.
Excel 2007 can handle more.

The Works download file is a comma-

I@ DataFiles

z @-a X

SizelT pe -

Hame 1. Navigate to N
8 Tc56-One-teartxt folder where data
file is stored.

2. Change the file
type to find to "Text
Files".

3. Click on the file
name.

4
e

6,663 KB Text Document

4. Click the
"Open" button.

Fieame: | 7

Files of type: IText Files (*.prny *.txt; *.csv)

-

Date Mod@
51620105,

J
!
¢
i
P
4

open |~

if

\,‘\ A p———— J -~ JrEs——— =

delimited text file. This means that the file uses a comma to separate the data fields
(columns). To open the text file, open Excel. Select Open from the menu.

1. Navigate to the folder where your data file is.
2. Select Text Files in the Files of type drop-down list. Note that Excel file type is
the default. You must change the file type in order to see your data file.

w

Click on the file name.
4. Click Open.

The Import Text Wizard dialog box will walk you through opening the file.

E
= .
Step 1 of 3: it bt et ' &
Click on the Delimited radio button and then ‘n@ 7”
Next. St gt of o [1 ] Fegrign: | 7 ceM Leed ates. = ‘
?
EEEE R

Gh TECIE COLE, "DURNE, BARBARA®,2004,306. 78, 06/00/ 2005, 00042002, | -]
Step 2 of 3: EENIEEN () W) P

—
B e I e T S Y

Specify that the mark used to define the fields is

the Comma. You can leave the Tab box checked

as well.

Click the Next button.

Step 3 of 3:
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Use the scroll bar to review the fields. Notice that the wizard gives a preview of what
the data will look like.

The default data format is
“General”, which means that Excel
will import text as text, numbers, as
numbers, and dates as dates. The
rule of thumb for non-date fields is,
if you are not going to do

l

")

‘General converts numeric values to numbers, date values to dates, and al
remaining values to kext.

e

Jater MDY B Advanced.. Gro

£ Do not mport column (skip) R
calculations on the field or the field 5
is not a date, then you should _— €
specify “Text” as the field type. e e T — . &
fields that contain numbers (last Kl _ 4
four digits of the card and the Er | e | e T Fme | ,S
Mwm\m__,‘r"‘“* S

Merchant Category Code) that
you will want to specify as text
fields. There are also other
fields, such as the merchant phone number, zip code, or address that will sometimes
have just numbers instead of alpha characters. Designate these fields as text. To do
this, click on the field and then click on the Text radio button.

¢ Import the Transaction Date and Post Date columns as “Date”.
¢ Import the Transaction Amount, STL, and Credit Limit columns as General.

Notice that you can “skip” a field if desired. However, since your download was
designed specifically for this workbook, you will not want to skip any fields. If you do
skip any fields, be sure to delete the corresponding column from the Data tab
spreadsheet.

Click Finish to complete the import process after you have assigned data formats to all
fields.

You data will display in Excel. Keep the file open. It will be referred to as the “data
download spreadsheet” from now on. It is recommended that you save this file so that
you do not have to run the report again if you have to start over.

Copy Transaction Data to the P-Card Compliance Workbook

In the next few steps, you will copy the transaction from the data download
spreadsheet to the template on the Data tab in the P-Card Compliance Analysis
Workbook. It is recommended that you read through these steps prior to actually
performing them in order to have an understanding of what you will do.

e Open the P-Card Compliance Analysis Workbook and click on cell I3 on the Data tab.
This will be the first blank row in the CH User Name column. See the screen shot
below. [NOTE: The screen shots in this document will be of the workbook using Excel
2007. If you have Excel 2003, your screens will look slightly different. The wording
of instructions uses Excel 2007 terminology. You will need to perform the same tasks
according to Excel 2003 steps. All cell references will be the same for both versions
of Excel.]
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Open the data download spreadsheet if not already open.

¢+ Delete the first row with the column headings. If you do not delete it, you
can delete it once you copy the data to the workbook.

¢+ If you downloaded reimbursements and payments to the bank with your
transactions, delete these rows as well.

¢ Click anywhere in the data download spreadsheet.

¢ Click CTRL-A to highlight all of the transaction data. [NOTE: Do not simply highlight
the entire spreadsheet. If you do, the data will not fit on the P-Card Compliance
Analysis Workbook’s Data tab when you try to paste it into cell 13.]

o Click CTRL-C (or use any other copying method that you are familiar with) to copy the
highlighted area to the Windows clipboard.

¢ Navigate to the P-Card Compliance Analysis Workbook and click on cell I13. (See
diagrams below.)

e Click CTRL-V (or use any other paste method that you are familiar with) to paste the
data into the P-Card Compliance Analysis Workbook.

E | & H | 1
Copy data from dowrlo

State  Red Flag
Purchase Day Begin Date Excl. Merchant? Exempt MCC? Contract MCC Level Il Eligible? ~ MCC? CH User Name
No No No No | #N/a | eN/A |

No No No No | ENJA | EN/A

SR oS L -3 wﬂ;’-’“ S S

A B C D E F | a | w ] e
1 Do not o or o D A Copy data from do\.?

State Red Flag
2 | Purchase Day Begin Date Excl. Merchant? Exempt MCC? Contract MCC  Level lll | Eligible?  MCC?  CHUser Name

Wednesday  04-26-2009 No Mo BURMNS, BARBARA
Thursday 04-26-2009 No MNo BURMNS, BARBARA
Wednesday 04-26-2009 No ] BURMNS, BARBARA
Qageaesa.,  Nog r....df.ai»..... 'u.d-bn wﬁ] ’wmwg%;\

When the data is pasted into the spreadsheet, the formulas in columns A through H will
calculate. To verify that all rows of data are complete, click on cell 13 and then click End
and the Down Arrow key to go to the last row of data. Ensure that the formulas are on
each row of data. If not, go up to the last row that has the formulas and copy columns A
through H down to all data rows.

If there are rows with formulas but no transactions, those rows can be deleted.

Mo Mo Mo ZORN, GAIL 5641 M
No No No  ZORN, GA - :
No No No . All rows beyond this point can be

deleted.
Mo Mo #NSA HN/A

No | sNfA " EN/A

For more information on the formulas and the lookup tables, see Maintaining the
Lookups Tab below.

Page |32



P-Card Audit Guide

Getting to Know the Data Tab

The Data tab contains more than just your transaction data. Formulas in Columns A
through H display information based on the values shown in the columns of the
spreadsheet.

e Purchase Day — This is the day of the week that the purchase was made on based on
the Purchase Date column. It uses this formula:

¢+ =LOOKUP(WEEKDAY(L3),{1,2,3,4,5,6,7},{"Sunday","Monday","Tuesday","We
dnesday","Thursday","Friday","Saturday"})

¢ Begin Date — This is the Monday of the week during which the transaction took place.
It uses this formula: =VLOOKUP(WEEKNUM(L3),weeks,2,FALSE). The VLOOKUP
formula looks at the week numbers shown in the “weeks” range on the Lookups tab.
This table needs to be updated annually as explained below.

e Excl. Merchant? — “Excluded Merchants” are those merchants that have already
been identified as Statewide Contract or State Entity contract merchants. The
formula in this cell looks at the “excluded” range on the Lookups tab. If it finds the
merchant name, it puts a “Yes” in the cell; if not, it puts a “No”. When/if you find a
contract vendor that has not been excluded, simply copy the vendor name to the last
row of this range. The formula on the data tab will automatically change. The same
field on the pivot table will update when you refresh the pivot table. It uses this
formula:

¢+ =IF(ISNA(VLOOKUP(N3,excluded,2,FALSE))=TRUE,"No",VLOOKUP(N3,exclude
d,2,FALSE))

e Exempt MCC?1 — “Exempt MCCs” are those MCCs that are probably equivalent to
one of the exempt NIGP codes listed on the State Purchasing Division web site. The
formula in this cell looks at the “exempt” range on the Lookups tab. If it finds the
MCC, it puts a “Yes” in the cell; if not, it puts a “No”. It uses this formula:

¢ =IF(ISNA(VLOOKUP2(T3,exempt,2,FALSE))=TRUE,"No","Yes")

e Contract MCC — “Contract MCCs” are MCCs that are associated with known
Statewide Contract merchants. The formula in this cell looks at the “contract” range
on the Lookups tab. If it finds the MCC, it puts a “Yes” in the cell; if not, it puts a
“No”. It uses this formula:

¢+ =|F(ISNA(VLOOKUP(T3,contract,2,FALSE))=TRUE,"No",VLOOKUP(T3,contract,
1,FALSE))

e Level lll - “Level " refers to a list of merchants that are known to transmit Level Il
detail information. As more are identified, the user can copy these names to the

' A NOTE ABOUT MERCHANT CATEGORY CODES: If you exported transactions from Works Payment
Manager to an Excel spreadsheet, then Excel assumed that the MCC will be used as a number. As a result,
it removes the leading zero in the four codes that begin with zero (0701, 0742, 0763, and 0780). You will
need to go back and designate the column as text and then manually add the zero to the beginning of
those codes in any transactions where they occur.

> A NOTE ABOUT THE “VLOOKUP” FUNCTION: This function will only work if it is looking up a value in a
cell formatted as “text”.
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“level3” range on the Lookups tab. The formula in this cell looks at the “level3”
range on the Lookups tab. The formula on the data tab will automatically change.
The same field on the pivot table will update when you refresh the pivot table. If the
formula finds the merchant name, it puts a “Yes” in the cell; if not, it puts a “No”. It
uses this formula:

¢+ =IF(ISNA(VLOOKUP(N3,level3,2,FALSE))=TRUE,"No","Yes")

e State Eligible? — State Eligible” MCCs are those that are in one of the four State-
authorized groups. These groups are (1) GASTATE, (2) GASTATE1, (3) GASTATE2, and
(4) GAATHTRAV. The formula in this cell looks at the “mccs” range on the Lookups
tab. It then pulls either “Yes” or “No” based on what is in the third column of that
range. This column corresponds to the old MCC Analysis workbook. It uses the
formula:

¢+ =VLOOKUP(T3,mccs,3)

¢ Red Flag MCC? — The formula in this cell looks at the “mccs” range on the Lookups
tab. It then pulls the value in the eighth column of that range. There might be MCCs
that are legitimate, authorized MCCs but that, for any number of reasons, the user
might want to review transactions at these merchants. To customize this function,
go to column X of the Lookups tab. Enter “Yes” on the row for that MCC. This
column uses the formula:

¢+ =|F(VLOOKUP(T3,mccs,8,FALSE)="Yes","Yes","No")

The remainder of the columns contains the transaction data downloaded from Works
Payment Manager. If you decide not to download one or more of those fields, be sure
to delete those columns from the spreadsheet. The formulas above look at specific
columns. The formulas will automatically adjust to reference the new column. For
example, if you delete column S (the merchant’s phone number), then the MCC,
currently in column T, will be in column S. The VLOOKUP formulas will then look at
column S for the MCC.

Jl HllylllllcllL Jl TTOTITEIET
L | =1F(1IsNA(VLOOKUB[T2 )pxempt, 2, FALSE])=TRUE,"No", "Yes")
C D™ E G

T TUITTITITCT T T TYOTITICT

=IF(ISNA(VLOOKUP(S3 Jexempt, 2, FALSE)=TRUE, "Ne","Yes"]
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Refresh the Pivot Table

The most efficient method to review the data is to use the pivot table, found on the P-
Card Compliance Pivot Table tab. Click on that tab and then anywhere in the empty

pivot table
that is \ A [ B 3 D E P v
1 Excl. Merchant? (Al =] >
there. 2 |Exempt MCC? (A1) 53 }
3 Purchase Day (All) E‘
4 | Contract MCC (All) [~] r
5
6 Sum of Amount Postl}ateE
7 Program Card Name ~ | Comp Supp Name E|MCCE|MCC Description | ~ | {blank) Grand Tof
8 |j(blank] = {blank) Hiblant{blank) ’
d . N - A
Devel Add-Ins Options Design
On the Options menu tab (Excel 2007), 2
click on the green refresh arrows. ] i % ! EF
The pivot table will populate. If you see Refresh Change Data || Clear  Select Iy
(blank) in any of the columns, this means Source ™ M ML
that the pivot table data range Data adlinns
encompasses more rows than you have ’“M“F
data on. This is . | =
not a prOblem- If | |Excl. Merchant? (All)
you want to |} |ExemptmcC? (All)

Purchase Day

change the data [ ractmce

(All)
(All)

aacic

source to include

only rows with [ SunofAmount 7

i I Comp Supp Name > MCC BMCC Description 4
transactions, you [ [&{blank) S(blank) (blank) F 4
can do that = AIRGAS SOUTH =I5169

Click on the Change Data Source

015150008 Dyt ante e

= CHEMICALS AND ;?LE
¥ aal o TTER T MG

Change PivotTable Data Source 7| X
button (see above), next to the Choose the data that you want to analyze
Refresh button. In the dialog & Select a table or range
box, click at the end of the cell Lable/Range! |Data!$n$2:(xm) =
range, backspace out the current € Lse an cxternal data source
row number, and enter the new Chose Conmeckion. . |
row number as shown and click Commaction name:
OK. The pivot table will
. . CKE I Cancel
automatically refresh. If it does

not, click the Refresh button.

="
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Pivot Table Design

The pivot table uses Report Filters (known as Pages in Excel 2003) to isolate
transactions based on specific criteria.

When the filters are set to pull all transactions, as shown by the (All) in column B (see
diagram), then all transactions are included in the pivot table. When the values in the
filters are changed, transactions that meet all criteria will be included in the pivot table
data. The transactions are still on the Data tab. They just aren’t included in the values
reflected on the pivot table.

Users who are comfortable with pivot

A B
tables can change the design to suit |1 |Excl. Merchant? (all) E]| -
their needs. It is recommended, |2 |Exemptmcc? (All) (=] :
though, that you keep a master copy |3 |PurchaseDay (A1) %
of the P-Card Compliance Workbook |2 /centract MEC (all) ;
with any Lookups tab customizations g™ w8, HIMW’

that you might have done.
Definitions

For more information, see Getting to Know the Data Tab above and Maintaining the
Lookups Tab below.

¢ Excl. Merchant? This term refers to merchants that have been previously identified
as contract merchants, such as Staples or W.W. Grainger. This filter corresponds to
Column C on the Data tab. As more contract vendors are identified, the vendor
name as it comes across from the Bank can be added to the lookup table so that it
can be excluded in the future.

¢ Exempt MCC? The State Purchasing Division has classified multiple NIGP codes as
being exempt from State Purchasing Division rules. The complete list of these is
found on the State Purchasing Division web site. Certain MCC’s have been classified
as exempt based on the NIGP that it would probably correspond with. This filter
corresponds to Column D on the Data tab.

¢ Purchase Day This filter allows the user to focus on purchases based on the day of
the week, such as Saturday or Sunday, in order to identify possible misuse of the
card. However, not all weekend purchases are inappropriate. The cardholder’s job
requirements will influence when purchases are made. This filter corresponds to
Column A on the Data tab.

e Contract MCC This filter allows the user to focus on transactions at merchants that
have the same MCC as a known contract vendor. It is helpful in identifying possible
failure to use contracts. This filter corresponds to Column E on the Data tab.
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MODIFYING THE PIvoT TABLE DESIGN

The pre-designed pivot table on the Compliance Analysis tab uses the merchant name
as one of the Row Labels. However, in your work, you might want to see cardholder
names instead of merchant names. To do this:

1.

Unclick the box next to the merchant name
(Comp Supp Name).

Click the box next to the cardholder name (CH
User Name).

You will want to have the cardholder name in
the first column of the pivot table, column A.
Simply drag-and-drop the field name to the
top. See diagram below.

You can also show the merchant name along
with the cardholder, either as the first column
or as the second column. Manipulate the
pivot table to determine the best way to meet
your review objectives.

§5 Row Labels

MCC g
MCC Descriptiof ¥
CH User Name | ¥

N

Bl

bo
Ei

Sum §

PivotTable Field List

Choose fields to add to report:

[v] Purchase Day
[JBeqin Date
[¥] Excl. Merchant?
Exempt MCC?
[w] Contract MCC
Level 111
[ 5tate Eligible?
Red Flag MCC?
[ CH User Name
an
Amount
[Purchase Date
[JPost Date
[¥] Comp Supp Name
omp Supp Siree
[ Comp Supp City
[JComp Supp State
[ Comp Supp ZIF
[ Comp Supp Phone
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SUGGESTED ANALYSIS STEPS

Using the filters and reconfiguring the pivot table allows you to select transactions for
review based on specific criteria. The suggestions for use in this user’s guide are not the
only possibilities but are intended to get you started. As you become more familiar with
the pivot table and the various formulas used to provide more information about the
transactions, you can reconfigure the pivot table in multiple ways to fine-tune your
review.

Open Market Purchases

Transactions at vendors that have not

been previously identified as contract _ P ——r
Excl. Merchant? No
or mandatory source merchants would |-
i " B Exempt MCC?
be considered open market” [
) Purchase Day (Al E]
purchases. These purchases will fall [ldevasnpgec P P it g (S

into two categories: (1) those at exempt
MCCs (NIGPs) and (2) those at MCCs
that are not exempt.

¢ Select “No” from the Excl. Merchant? Report Filter. The pivot table will reflect the
merchant name and the total dollar amount of transactions at merchants that have
not been previously identified as a Statewide or State Entity contract or as
mandatory source regardless of the NIGP. If you have customized the merchant list
to include your State Entity merchants, these will be excluded as well.

e Perform any or all of the following steps. Each activity is designed to be done
separately, not at the same time.

¢ If a merchant has more than $5,000 in spend during the cycle, pull all transactions
with that merchant from Works Payment Manager for the previous six months to
determine if this is an opportunity for a State Entity contract. If you have access to
queries in PeopleSoft, you can also pull
spend there to determine if between the

Purchase Day (All) E]T

two methods of procurement, P-Card and
purchase order, there is enough spend to
justify the effort to create a contract.

¢ Select “No” from the Excl. Merchant?
Report Filter and the Merchant Category
Codes shown in the Contract MCC Report

Contract MCC

{al)

Sum of Amount

Comp Supp Name

= 4IMPRINT

=IDISPLAYS 2 GO

= DISTINCTIVE DESIGNS

= SUMMER CLASSICS, IN

] 5964

= BRIGHT SOLUTIONS FC

[ 5969

T4

-] 5111 =

Filter (i.e. select every value in the list SAMERICAN TYPECULT} -~ === =
e Y = MAGNA PUBLICATION| [ Selzct Multiple Itzms W

except the “No”) to determine merchants = CONSULT-PRO ‘m p—
that have not been previously excluded AND HiZieaaab-9t-. =
that have the same MCC as an excluded
merchant. These transactions could be
cases where the cardholder could have or :

: A I B ]
should have purchased the items from a 7 [— -
contract vendor or from a mandatory 2 ExemptmcC? No ¢

| 3 |Purchase Day (All) :
source. 4 |Contract MCC 1l
R o v o *'—EIM
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To see these transactions, double-click on the dollar value. The transactions will be
copied to a new spreadsheet in the workbook. Review the documentation to determine
if the items purchased were available on a contract.

Select “No” from both the Excl. Merchant? and the Exempt MCC? Report Filters. The
pivot table will now reflect transactions at merchants that have not been identified as
contract merchants AND where the MCC is not exempt. You can also select the known
contract MCCs from the Contract MCC Report Filter as described in the previous activity.
Review these transactions to determine if the cardholder(s) should have used contract
merchants. Remember that even if a purchase is exempt from State procurement
regulations, the cardholder must still follow the Order of Precedence and use contract
vendors.

Split Purchases
Add the Purchase Date field to the pivot table

as a Column Label. Determine if any vendor [ Tields between areas belaw: |

had spend in excess of $5,000 on a single day or [ RepertFilter Column Labels
on consecutive days. (HINT: The easiest way to [Exd. Merchant? Purchase Date
scan through the data quickly is to apply [ExemptMCC? -

Purchase Day
Contract MCC =

conditional formatting to highlight any cell
greater than or equal to $5,000 and then look

for the highlighted cells.) H Row Labels ¥ Values

If the answer to either of the following ?@M"'u‘xf\

questions is “Yes”, then investigate for possible
split transactions.

¢ Did a single cardholder have all transactions?

¢ Did two or more cardholders in the same work unit make the transactions?

Weekend Purchases

A [ P [
Select “All” from each Report Filter to |1 |Excl. Merchant? ﬁ (al) =
. . I 7
reset the pivot table to its original |2 EXeMPtMCC? =iy (Al =
. . . 3 |Purchase Day (Al -
configuration. Using the Purchase Day |, |contract mcc =T / A
Report Filter, select “Saturday” and |[s - Saturday ;
. . e | -] Wednesday
“Sunday” to review transactions made |6 [Sum of Amount [ Thursday ?
7 Comp Supp Name :----DFriday
on the Weekends' 8 | = AIRGAS SOUTH -] Monday CHs
. . . = -] Tuesday
Review such  combinations as | = S00GOFEDEX
hant name, MCC description, and - SUMPRINT
merchan
, ’ ﬂ..,grws\g 5&!"“""‘"““‘“‘ . J“""’\

cardholder user group to determine if
transaction would be
If not, investigate those

a weekend
reasonable.
transactions.

You can also select “No” from both the
Excl. Merchant? and the Exempt MCC?
Report Filters to eliminate transactions
from contract merchants or at exempt
MCCs. If a cardholder is abusing the

=IAVALA TNTERNATIONAL INC

EURNS, BARBARA

= EXPLORATRACK

BURNS, BARBARA

=IORGANIZE COM

BURNS, BARBARA

=/ BAILEY STREET

BURNS, BARBARA

'=lAmazon.com

[T @ [T [T &=

with the same vendar.

Blank rows in column A
indicate multiple cardholders

ADAMS, DAWN C
ADAMS, TRACEY
ADKINS, KENNY
Akins, Harold
ALLEN, REBECCA
shwaorth, Dennis
RRETT, JEANNIE
sford, Amory

i e |

OUTIER, PATRICK
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card, the abuse will probably not be at contract or exempt MCCs simply because of the
nature of the transactions. However, you might want to investigate some contract
transactions, such as automotive parts or office supplies.

Merchant Utilization

There are times when you might want to see if there is a merchant that only one
cardholder is using. It is more likely that any personal use will be at merchants that
other cardholders do not use. To determine if there are any merchants that fit this
category, configure the pivot table so that the merchant name is the first Row Label and
the cardholder name is the second Row Label.

Keep in mind that if only one cardholder uses a merchant, this does not indicate
fraudulent use. The cardholder’s job description, work unit, and other factors
determine which merchants a cardholder uses. Moreover, it is possible for a cardholder
to make personal purchases at merchants that everybody uses, such as Staples or Home
Depot.

Combined P-Card and Financial System Spend

Periodically, you should download purchase order spend and vouchers without
purchase orders from the financial system for the same time period and compare to
spend on the P-Card. The Agency/University Procurement Officer should be doing this
as part of the regular spend analysis.

Use of the P-Card increases efficiency in most procurement operations and eases the
burdens on the Accounts Payable staff. Review the list of vendors used in PeopleSoft
with the merchant names in the P-Card spend data. Answer these questions:

¢ Are buyers who are also cardholders both issuing purchase orders and using the P-
Card with the same merchant?

¢ Are there local businesses on the list of purchase order vendors that probably serve
the general public? If so, then they probably accept credit cards and would accept
the P-Card.
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SAMPLE CRITERIA P1voT TABLE

The Compliance Pivot Table tab summarizes transactions by merchant name. This
allows you to view the merchants involved when you are looking for suspicious
transactions. The Sample Criteria Pivot Table tab contains a pivot table that
summarizes transaction data according to “Excluded Merchants”, “Exempt MCC”, and
“Contract MCC” status. The tab contains instructions on how to use the filters to isolate
transaction dollar amounts at all merchants meeting the criteria selected in the filters.
This tab is useful if you want to kick transactions out to separate spreadsheets based on
their criteria in order to select a representative sample from each category.

J= [ Refresn FIvol Taple

H I ] K L M N o P Q R Sud

a. Click anywhere on the pivot table
b. On the Pivot Table Options tab, click the green refresh button

a. Column A -- Filter on "Na" to exclude merchants not already identified as contract or mandatory

b. Column B -- Filter on "No" to exclude MCC's not associated with an exempt NIGP

. Column D -- Double-click on dollar amount for the "No" value in column C to see transactions that are:
= Not at excluded merchants
= Not at exempt merchants
= Not at a possible contract MCC

a. Column A -- Filter on "Na" to exclude merchants not already identified as contract or mandatory
b. Column B -- Filter on "No" to exclude MCC's not associated with an exempt NIGP
. Column C-- Filter on all values except "Ma" and "Blank" (i.e. filter on all MCC's shown)
d. Column D -- Double click on dollar amount to see transactions that are:
= Not at excluded merchants
= Not at exempt merchants
= Are at a possible contract MCC

NOTE: If there is a dollar amount associated with a "Blank" total, then the pivot
table is not reading all data. Ensure that formulas in columns A-H are copied
down to all rows of data on the Data tab.
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MAINTAINING THE LOOKUPS TAB

The Lookups tab contains all of the ranges of data used in the VLOOKUP formulas on the
Data tab. Some of these ranges can be customized to fit your needs.

Excluded Merchant (columns A-C)

Merchant names do not come across from the Bank in the same format as the vendor
name in the PeopleSoft financial system. As a result, you cannot simply put all of the
contract merchant names on a spreadsheet and use it. As contract merchants are
identified, they must be added to the lookup range. The State Purchasing Division
Process Improvement Team will update the P-Card Compliance Analysis Workbook on a
monthly basis if any new merchants were identified.

You can also maintain the list on your version of the workbook. If you identify a new
SWC or State Entity contract merchant, those merchant names should be entered on

the list.
Go to the first empty row in Column B, and enter ' |
“ o A B C D
the new vendor name and “Yes” in column C. [ iocuded  Excluded Merchant Answer ;
The formula on the Data tab will automatically [17s] 47132 FLETCHER OILC Yes )
reflect the new value. You will need to refresh [ HARRISON TIRE COMPANY ves
. . . 1178 FLETCHER OIL CO INC Yes

the pivot table in order for transactions at the |17 HIGHLAND TIRE AND AUTO ves
merchant to be excluded. 20 PHOENIX OIL CO es

1181 Mew vendor name here IYes _I

182

Yes
Level IIIl Merchants (columns E - F)

The Process Improvement Team has already
identified several merchants that transmit this

level of detail. These are merchants are already T - | rar_
on the Lookups tab. You can determine if a Level3  Level Ill Merchant

merchant transmits Level Il (line item) detail by 1800GOFEDEX 10010007 ;
creating a report in Works Payment Manager 4IMPRINT

that pulls data fields from the “Transaction 9614 RAPID

Details” section. There will be one line for each ABM FEDERAL SALES INC

} S . . ACCU-T,
line on the invoice or receipt. When you find a \M sl
new one, simply add the merchant name to the

list as you did for the Excluded Merchants.

t [F] Alignment ‘-
Weeks (columns L - N) N2+7 ) '
There might be an occasion, such as looking at
split purchases, when you might want to see all Weeks Week %Begms J
transactions during a certain week. Column B 12/28/2009
on the Data tab reflects the Monday of the 1;41;2010
week during which a transaction took place. 3 1,»"11,-"2010
This table must be maintained annually. Enter 2
the Monday of the week during which the new .‘ - M 3‘

year starts. For example, if January 1*" is on a
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Friday, the previous Monday would have been December 28™. Enter that date in cell
N2. The remaining date cells will calculate based on the previous date plus seven days.

State Eligible MCCs (columns P - W)

These columns show all Merchant Category Codes and the State-authorized MCC groups
to which they belong. There are not many MCCs that are not in at least one group. The
Process Improvement Team will update this list if new MCCs are added to groups or if
new groups are added. If you have received approval to use an MCC that is not in one
of the State-authorized groups, you can change the “No” in column S to “Yes” so that
the formula on the Data tab will mark that transaction as conducted at an authorized
MCC.

T Connedions I Sort & Filter 11 Data Tools Il Oufline '!][_‘
fie | McC >
[ »p [ @ R [ s [ = [ v [ v [ w [ x [g
All IMCC Description State Eligible  GASTATE  GASTATE1  GASTATE2  GAATHTRAV  "Red Flag"? }

'0742 | VETERINARY SERVICES Yes Yes No No No

M..Q?fi _wgwugfz_ coopfv_ﬂwms Yes '-t\No"“ - !ﬁo ' e . 5 ,

“Red Flag” MCCs (columns Q - X)

If your want to focus attention on

1 . o pe e | i
transactions at merchants with specific J: = -
Merchant Category Codes, even if they s ommssimsisnorasamee s i

094 PRECIOUS STONES AND METALS WATCHES AND JEWELRY

are allowable, you can use the “Red Flag” iwfi““si?“ T —. _
column on the MCC table to do this. e Mo o A
Simply put the word “Yes” in column X on

the row for that MCC. The Data tab will reflect the “Yes” in column H. You can either
filter on those transactions on the Data tab or add this column to the Report Filters on
the pivot table. You can also use this column to focus on specific spend areas.

b %10

\

Exempt MCCs (columns Z - AA)

The State Purchasing Division has ruled that certain
NIGP (National Institute of Governmental Purchasing) |Y Z A” |
codes are exempt from the State Purchasing Act. This Exempt_JExempt MCC

0780
3000

http://doas.g:f\.gov/StateLocaI/SPD/Docs SPD_General/ \-..-\‘_régﬂj
NIGPExemptList.pdf

list is available on the SPD website at

The State Purchasing Division updates this list if other NIGPs are determined to be
exempt. The Process Improvement Team has identified Merchant Category Codes that
are possible equivalents of the NIGP code. These are shown on the Lookups tab in the
“Exempt” range name. Since there is no direct correlation between MCCs and NIGP
codes, this list is not guaranteed to be infallible. However, this Report Filter can exclude
some transactions that might be exempt. Transactions at some merchants with
“exempt” MCCs might not be exempt when the details are reviewed. When conducting
an audit, the user should sample these transactions to determine if they are exempt.
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This is especially critical if a single purchase or multiple purchases exceed the $5,000 bid
limit or were purchased from a non-contract vendor. Remember — cardholders must
still follow the Order of Precedence, even if the NIGP/MCC is “exempt”.

While the user can add MCCs to this list, it is not recommended unless the Process
Improvement Team updates it since you might exclude some transactions that are, in
fact, non-compliant.

Contract MCCs (columns AC-AD)

Contract MCCs are those MCCs that are associated with U atT

known Statewide Contract vendors.  Purchases at AC AD | AE

merchants that have not been previously identified as Contract IMcc

contract AND have the same MCC represent possible
failure to use a contract merchant. As with the exempt
MCCs, this list is not guaranteed to be infallible. The user [,
should not assume that all transactions could have been
purchased from a contract vendor. Only review of the
documentation will determine that.
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DOCUMENTATION REVIEW Georgia-

PURCHASES OF SUPPLIES AND MATERIALS

There is no one right definition of adequate documentation for all transactions. The nature of
the goods or services received determines what information the invoice or receipt must contain.
However, all invoices should contain basic information about the transaction. These are:

Vendor or merchant name
Transaction date
Line item information

¢ Quantity

¢+ Description

¢ Unit Price

¢ Line Price (quantity times unit price)

Total invoice amount
Attestation of receipt of goods or services

¢+ If the documentation is a cash register receipt, then the cardholder’s
signature should be on it.

¢+ If the items were shipped, the receiving employee should sign the packing
slip, and the invoice if it comes in the shipment, and send to the
documentation to the cardholder. The cardholder should keep the original,
signed packing slip and invoice with the transaction log or monthly billing
statement.

Specialized Transactions

In addition to the above information, good accounting practices dictate that certain
transactions have the following documentation:

Subscriptions (Newspapers, magazines)

Length of subscription or renewal

Name of periodical

Name of employee for whom periodical was ordered
Delivery address for the periodical

Cardholder should sign original order or renewal form
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Organizational Memberships

¢ Name of employee for whom the membership is paid
e Length of the membership period

Freight Charges (when billed by a third party)

e Origination point

e Destination point

¢ Nature of items being shipped

¢ For payments to shippers such as FedEx and UPS, the cardholder should attach the
statement from that company showing all shipments and the amounts for each
individual delivery.

Conference Registrations

¢ The Department of Audits and Accounts does not consider conferences registration
fees to be employee travel. Therefore, cardholders can use the card for registration
fees. Itis up to the agency or institution to prohibit this type of transaction. The
documentation must include:

¢ Copy of the registration showing who is attending
e Copy of the agenda or program
Airline Tickets

¢ A copy of the itinerary showing the name of the employees flying and the purpose of
the trip must support charges for airline tickets. If the agency pays for non-employee
flights, then the documentation must include an explanation for the charge.

e The cost of shuttles to and from the hotel and the airport are employee travel
expenses and cannot be put on the purchasing card. Employees must pay these
charges and receive reimbursement on a travel reimbursement form.

Group Meals

The State Accounting Office issued its Employee Group Meals Policy on October 1, 2006.
Refer to the Statewide Travel Regulations on their website. Meals that meet the
requirements for group meals must have the following documentation in addition to the
invoice from the caterer or restaurant providing the meals:

¢ Prior written approval from the agency or department head
e Roster signed by all employees participating in the event

¢ Agenda or other documentation showing the purpose of the event at which the meal
was served

Printing
e Copy of finished product

¢ Job order or other document showing the number of documents printed
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Newspaper or Internet Advertisements
e Copy of the newspaper advertisement as printed and the date(s) printed

® Print screen of the actual advertisement on the Internet site.
OTHER PURCHASES

Payment from Statements

Cardholders must pay from an invoice when at all possible. If a merchant regularly
holds invoices and generates charges only from a monthly statement to its customers,
then the cardholder must retain all individual invoices and attach them to the statement
as documentation that the statement reflects the total amount of charges. The
cardholder should staple the invoices to the statement and attach an adding machine
tape proving that the total of the invoices matches the amount on the statement.

Recurring Monthly Charges (Services)

If merchants do not send out monthly statements, either through regular mail or via
email, then the cardholder should attach a copy of the original order for the service
showing what the monthly amount will be and the length of the term of service. The
cardholder must document any change in the amount charged compared to the amount
shown on this documentation with a new notification from the merchant. Notes
generated by the cardholder to this effect are not adequate documentation for the price
increase or decrease.

Non-Inventoriable Assets

State Entities must record any single piece of equipment with a cost greater than $1,000
for agencies or $3,000 for colleges and universities in asset inventory. State policy
prohibits use of the purchasing card for the purchase of any asset that must be included
in the asset inventory.

The State Purchasing Card Policy allows the purchase of equipment under these
thresholds and recommends that entities also maintain any easily misappropriated
equipment, such as digital cameras, in the asset inventory. Documentation for this type
of purchase must include:

e Location of the items purchased

e Asset tag/decal number (if not indicated on the invoice, auditors will request to
verify the existence and location of the asset)
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CONFIGURABLE REPORTS IN WORKS PAYMENT Georgia-
MANAGER

OVERVIEW

Works Payment Manager (Works), the on-line card management system provided by
Bank of America, uses reports to download transaction data for analysis with either
Microsoft Excel or Microsoft Access or to a PDF document for reports that will be
printed. For most analyses a State Entity will want to do, the data can be downloaded
to Excel. However, if the number of rows exceeds the row limit in older versions of
Excel (65,535), then the transactions must be downloaded to a text file or to multiple
Excel files. Both types of files can be used in Excel or in Access.

Works allows the user to select which data fields to include in a report or download.
This is done in the Configurable Reports section.

/= https:/ /paymentZ.works.com;?#

CREATING A REPORT Bankof America <2

After logging into Works, B Tasks

Ll
= Administration

1. Click on Reports to display the list of report

options s
E Reports
2. Click on Reports to display the list of report @ Bookmarks

categories Dashboard

i ; & CxCo Dashboard
3. Report categories are shown in the Hoe Dashaoar

illustration to the right.  Transaction

I' Reports

B Reports

downloads are done in the Spend Reports EPI—

. CxCo Audit Reports
section. Card Raports

. CxCo Card Reports
4. Click on Spend Reports. A

CxCo Org Reports

Request Reports

=l spend Reports

Bl cico Spend Reports

Scheduled Reports
Completad Reports

o ckmarks
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Works has certain standard reports that can be run as-is. These reports can also be
configured by adding and removing data fields. In order to configure a report, the user
has to start with one of the existing reports, or templates.

e Click on the arrow in the Report
Template drop-down list.

Choose a Spend Reports Template

e To download transactions, start with

the Billing Statement report by clicking
on it.

4 [ Step 1: Choose a Spand Raeports Ts
d ’:epnrt template: |

Report datz is cu

. . . Q_ Biling Statsment
e The Report Configuration screen will ‘ﬁm—;gégm :rg.f%c;ions
emo
display. This screen has six sections. Payable Alocat

Payable Alocation Detal
Spend By MCC

Recently Used Reporis
system : Billing Statement
system : Spend By MCC

Achoose from all i’

Report Configuration Screen Sections

Stepl: Choose a Report Template

Once you select your template, shown above, options for the template display. The
default display is Show Expert View, which allows the user to see all data fields available
and other report options. The Simple View allows the user to change a template, to
specify the output format (e.g. Excel), and to enter parameters in the filter options.

1. You can change the template if you decide the one you chose is not correct.

2. Simple View displays just the fields to enter criteria for transaction selection. To
show just the Simple View, click the

button here. The button name will 1
change to Show Expert View. Both 3
views are discussed in more detail ChangeTemplahe|
beIOW as with all system reports. you are able to configure

3. Use Last Run Settings allows you to @ '4]

ImmEdlately run a report using the Shaw Simple Uiewl Use Last Run Setﬁngsl Reset To Defaultsl

template as it was configured for the
previous run.

4. Reset to Defaults sets the template
back to the original Works design settings.

Step 2: Choose the Export Formats

| Step 2: Choose the Export Formats |

Available formats are PDF, Excel, and Delimited
Text. Click the desired check box.

Export as: [ PDF [ Excel [ Delimited Text

Paper size: Im

Orientation: { Portrait (+ Landscape

The Paper Size, Orientation, Add summary data to
the header options are only available for PDF
documents.

Add summary data to the header: [
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If you select Delimited Text, you
have the option to select a
delimiter (e.g. comma), what to do
if the selected delimiter occurs in
the field value itself, and to include
the field names as column headings
on the first row of the file. This is
helpful if the text file will
eventually be opened with Excel.

| Step 2: Choose the Export Formats I

Exportas: | PDF [ Excel [¥ Delimited Text

Delimiter: I . {comma) vl When delimiter occurs in text: IQuote entire field 'l

Newline style: | nix style/LF ~ | Include headers: [v

Step 3: Configure Report Columns

Included columns:

Last 4 Digit
This is the section where you tell Works mec 'gbs
XN Number
Payment Manager which data fields you Post Date
. N Purchase Date
want to include in the report. The Included Amourt
it
Columns area displays the fields currently Debit
. Payment Amount
on the report. These fields can be moved
up or down, deleted, or edited by clicking

on the buttons to the right of the listing.
The field can be moved to the Sort Columns
list by clicking the down arrow button
beneath the listing.

&,

The Sort Columns list allows you to move fields up and down to change the sort order or
to delete the fields from the sort order using the same type of buttons as the Included
Columns listing.

The Available Columns listing categorizes available data fields based on the type of
data. The categories that are most useful for the State of Georgia are:

¢ Allocation — information on how a transaction was allocated in the General Ledger
e Card —information about the cardholder’s card
¢ Card Profile — spending limits for the profile to which the cardholder is assigned

e Cardholder —information about the cardholder. The most useful field here are the
CH User Name.

¢ Cardholder Group — the work unit or other grouping to which the cardholder is
assigned.

e Company Supplier — information about the merchant.

e Orig[inal] Transaction — basic information about the transaction

e Program Card — information about the State Entity’s card program
¢ Transaction —additional information about the transaction

e Transaction Detail —information about Level Il detail, when available
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To select a field to include in the report:

1. Click on the field name

Available columns:

CH Payee ID LI @ Im:ludefl .l:nlnmn
. . CH Phone 1 Last 4 Digits
2. Click the arrow button to move it to the CHProre2 e mer
F i CH Liser Name Post D
Included Columns listing. i = Pirchase Date

J Constant

Cardholder Group
Grmp Create Date

Use the up and down arrow buttons shown above
to arrange the columns in the desired order. Use
the down arrow button under the field listing to
indicate the fields to be used f or sorting. Arrange the columns in the desired sort order,
using the up and down arrow buttons. Click on a
field name and then the X button to delete a
field from the sort layout.

[” Insert page breaks for summary data to: [0 pzo= brechs

=] (eoi

=t Directions

Click on the Specify Sort Directions button to
reveal the sort fields and click the radio button
for either Ascending or Descending.

Last 4 Digits: (¥ Ascending { Descending
Post Date: (+ Ascending ( Descending
Txn Number: (¢ Ascending { Descending

Step 4: Add General and Column Filters

Any field, regardless of whether
or not it is included in the field

Post  em Description El
list for the report, can be used as ESINR o Bip (ot Comart s
. . . ttem Number
a filter. A filter is where you tell e Prcs
Works Payment Manager to limit e o e -
the transactions it pulls based on o EEE = E
certain parameters, such as Transactiontvpes 2l ,'Z o e
between certain dates or for a ﬁ”i“f’eb‘t @
. [V Purchase
specific cardholder or merchant. I Reimbursement

¥ Payment
ls

Last 4 Digits: x| [|s axacty ~| 272

1. Click on the drop-down
Date: iIEDMI 07/18/201

arrow to scroll the fields.
Click on the desired field
name to display it in the

filter list. |
Select dates:
2. The filter list displays below the S — - e R
drop-down list. When Works runs olefsfe 7 |z Js Jroju [<] @1/ [Els
i 1|11(1z2(13|14[15]1&[17|L / /
the report, only transactions that 0 [erefzofztlezloalee
; ) ) 23|26[z7|238[z330[51 ~ e - )
meet ALL of the criteria will be TR RR R A - ;earth*id:*et - ie:ezej :fe‘t‘h
pulled. In the example above, only W C Cydetodate " Selected cycle
. P e e (el d (o I
transactions on the card that ends g 2 CE R S
in the Last 4 Digits and are on the @ pastls|days
Post Date shown will be retrieved. -
3. Click on the x button next to a
filter to remove it. = == —ssees
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Specifying parameters

Some fields used as filters have a button to click in order to enter the parameters. In
the illustration above, clicking on the Date... button next to Post Date displays the Select
Dates dialog box. Select from any of the pre-designed parameters or manually enter
the dates in mm-dd-yyyy format. Click Finish to return to the report design screen.

Step #5: Bookmarking

Bookmarking is the Works word for
saving the report template.

1.

Click on the checkbox next to
Bookmark this report template.

Enter a Bookmark name (report
name) and Description for the
report.

Make sure that the Personal radio button

all Works users at your Entity.

Step 6: Scheduling & Expiration

Reports can be run Now or at a later specified
time. Reports can also be scheduled to run on
a recurring schedule (e.g. every Monday
morning at 7:00). Works will also keep a copy
of the report for a specified number of days.

1.

Specify the Job Name. This can be the
name of the report. However, if you
are running several versions of the
report (e.g. multiple cardholders), you
will want to give each one a different
name so that you will be able to find it
easily later.

Click Now to run the report now.

Indicate the number of days to keep the report in the Works

system.

| Step 5: Bookmarking I

¥ Bookmark this report template: 2
B

kmark name: (Il Statement

Description: [Siate for my purchasing card|

Scope: (¥ Personal { Company { Both

is selected.
administrators can create Company reports. Company reports can be seen by

Only Works

Create reports for employees: [£] Employess..| (unszp

Schedule:
% Now
" [ Later...| unspecifiad

" [ Recuning...| unspecified @
Keep the generated report for 2y=.

Click the Submit Report button in the lower right-hand corner.

Page |53



P-Card Audit Guide

SCHEDULING REPORTS
Choose a Date and Time
e Click on the Later... radio button and the Later...
button. The Choose a Date and Time dialog box will pate: [y =f|22 =], [2010 =]
display. Enter the date and time and click OK. Time: [ I [ Cam & em

¢ Click on the Recurring... radio button and the
Recurring... button. The Report recurrence dialog
box will display. Enter the
information and click OK. Report recurrence CL

e Click on the Submit Report button to
schedule the reports.

= ﬂl Cancel |

pany L[ Both

@ Every [12] days ot [Manght =]

C every [Sndsy =] =t Mgt 5]

€0 Every month on the [1st =] at [Vidmgnt =]
© Every silling cycle plus | | =] days

" Every quarter starting |Jaruay =] |1t =

&I Cancel
RETRIEVING A REPORT
Works Payment Manager saves reports for the number of days e e o
e . . . BankofAmerica <2~
specified when the report was run. The default for this time period is
seven days, but the user can change this to any number of days. B rasks
E Administration
Reports are stored in the Reports section under Completed Reports. [—
@ Reports
1. Click on Reports to display the list of report options. B Bookmarks
® Dashboard
2. Click on Reports to display the list of report categories. B cece Dechbcerd
3. Click on Completed Reports to display all saved reports.
4. The list of reports that have been run and are still in the -
Spend Reports
Works system and available for download displays on the B cco cpond Repeie
screen. Scheduled Report
! Completed Repors ) |
5. Click on the report name |g kmarlcs
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6. The Report Info screen will display at the

bottom with information about the report and |, status + |} e+ | Ropuested ExportT
with three option buttons in the lower left- [aram = rdrme= -

Z2:06 PM Ready
hand corner. T v

| Add Another Format | | Download Delimited Text I | Run Report Again I 4

a. Clicking the Add Another Format button allows you to select a different
format (e.g. PDF instead of Excel). Works will run the report without any
other input from you. The report will show as Awaiting Processing and
both output formats will display in the Requested Export Types column

b. Clicking the Download [file format] button
will start the download process for the Do you want to open or save this ile?
report. You can either Open, Save, or Name: Previous Month - Selectedltxt @

Type: Text Document

Cancel the operation. From: paymentz.works.com
@ Open Save | Cancel I

¢ Click Open to open the file and
view on the screen.
¢ Click Save to save the file to a
network drive or the hard drive of your computer.
¢ Click Cancel to stop the download process.
c. Clicking Run Report Again takes you back to the report configuration screen
so that you can modify the report design or enter a different set of
parameters for the same report.
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MANAGING “BOOKMARKS”

Bookmarks are the templates for the reports that you
have created. You can delete those that are no longer
needed by going to Reports = Bookmarks >
Management on the menu on the left-hand side of the
screen.

=l scheduled Reports

Completed Reports
B Bockmarks

Management

Click on Management to display the reports divided into

) Personal Bookmarks
sections for Personal Bookmarks (those only you have

access to) and Shared Bookmarks (those that multiple Bookma
users have access to). Only someone with L |All spend plus Level 11 - B
administrator privileges can create a shared bookmark. v ) BOR far MCC

? Bzsed on dollars

To delete a bookmark, click on the box next to the
Bookmark Name and then the Delete button in the
lower right-hand corner. Make sure that you want to
delete the bookmark because you will not be prompted
to make sure once you click Delete.

Eilling

Personal Settings

Cemmunicaticns

If you need additional help with Works Payment Manager B s ey

reports, you can access the Works training information by @Training and Help )
clicking on Tools - Training and Help ->Documentation to DoclimSgEanon
display the Works Payment Manager user manual. This ® Videos
manual can also be downloaded and saved as a PDF file. R Live Training

I% Release Notes

= Tip of the Week
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Georgia-
USING EQUOTE FOR OPEN STATE ENTITY CONTRACTS

OVERVIEW

The APO/CUPO identifies a need for an Open State Entity Contract through analysis of
purchases. The need for an Open State Entity Contract is justified by the following:

¢ The need cannot be met through a statewide contract, an existing entity contract, or
a mandatory source;

¢ The need exceeds (or is expected to exceed) the $5000.00 threshold within a given
fiscal year and must be competitively bid; and

¢ The exact quantities or total number of orders are not known.

The following describes the action steps for the APO/CUPO for creating an Open State
Entity Contract according to 7-Stage Process:

1. PURCHASING STAGE 1-NEEDS IDENTIFICATION

1.1 Through purchase analysis (through PeopleSoft and WORKS Payment Manager),
the APO/CUPO determines that an Open State Entity Contract is needed as described
above.

1.2 The APO/CUPQ’s analysis of previous and anticipated future purchases should
assist the APO/CUPO in identifying associated stakeholders and the benefits associated
with a State Entity contract (e.g. savings associated with aggregated spend). The
APO/CUPO should review purchases and future needs of all of the State Entity’s
divisions/business units.

2. PURCHASING STAGE 2-PRE-SOLICITATION

2.1. APO/CUPO assembles a sourcing team, which consists of existing stakeholders
(i.e. end users, project facilitator, etc.). APO/CUPO facilitates meetings by the sourcing
team to prepare for the solicitation preparation stage:

Review existing solicitations, contracts, etc., to identify suppliers with whom the State
Entity has conducted business and also analyze the market to identify additional sources
of supply, market dynamics, and industry standards (i.e. minimal warranty terms, etc.)

Discussion: Analysis of the market and sources of supply provides critical information to
the sourcing team, including understanding how items may typically be bundled or sold,
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which will assist the source team in organizing the solicitation. For example, if all
suppliers provide all of the needed items, then the sourcing team may consider making
a single award. However, if the market analysis reveals there are suppliers that provide
some but not all items, then the needed items may be best organized into categories or
subcategories with split awards.

Establish a core item list for current needs and possible future needs. The core item list
contains the essential items expected to be purchased by the State Entity as a whole.

Determine what other items in addition to the core items list should be included in the
Open State Entity Contract. For example, are there value added items such as extended
warranties or additional services which should be included? Is it desirable to establish a
minimum percentage discount off of the supplier’s catalog?

2.2. APO/CUPO should determine best sourcing method* based on items to be
sourced.

*The remainder of this document has been developed based on the assumption that the
RFQ is the desired sourcing method and that the APO/CUPO will utilize eQuote to
conduct the RFQ.

PURCHASING STAGE 3-SOLICITATION PREPARATION

3.1. To fully develop the RFQ, the sourcing team must address several key questions
in conjunction with the APO/CUPO:

What are the bid factors? For example, will the RFQ request references or minimum
experience? Is there any required certification which the supplier must possess?

What are the key requirements and terms? For example, are there certain minimum
performance levels which must be met by the supplier such as delivery or response
times? How will the State Entity address requests for price increases? The
RFQ/contract must stipulate that cost will remain fixed throughout the duration of the
contract. In addition, the RFQ/contract must state that no price increases will occur
unless it is approved in writing by the State Entity. The APO/CUPO may wish to include
a price escalation clause, which establishes the basis for determining whether a price
increase may be granted (for example, whether there is an increase in pricing according
to a designated product index) as well as the limits to the number of price increases
which may occur as well as the amount.

Should the APO/CUPO schedule a site visit and/or pre-bid conference? If so, should
supplier attendance be mandatory? How much time should be permitted for supplier
questions?

How will pricing be requested? There are three common approaches for requesting
pricing, and all three approaches require a core items list (representative market
basket). The first approach is to send the core item list as part of the solicitation and
have offerors bid on the specific items referenced on the core items list. The second
approach is to request the offerors provide their catalogs and provide a discount off
their catalog price. The third approach is to standardize on and reference a specific
manufacturer’s catalog and request offerors bid a discount off the catalog price. There
are strengths and weaknesses for each approach that need to be explored by the
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sourcing team prior to selecting an approach. Additionally, the sourcing team must
decide if the core items will be identified by line item within eQuote OR if the
APO/CUPO will attach an Excel sheet with the list of the core items.

¢ Note: SPD will update eQuote training and the eQuote manual to address these
options.

¢ Note: Items requiring particular branding will require Sole Brand Justification (SPD-
NI003b).

What other documents will be included with the RFQ? For example, for all contracts
with an estimated value in excess of $100,000, the APO/CUPO must request verification
from the Department of Revenue that the supplier is not a prohibited source.
Therefore, in this example, the APO/CUPO must attach the Sales and Use Tax
Compliance form. In addition to identifying necessary forms, the APO/CUPO must
attach an approved contract which identifies any renewal options and how those
renewal options will be utilized. (Note: SPD must provide prior written approval in the
event the State Entity desires to establish a contract which will exceed five (5) years.)

3.2 The APO/CUPO must finalize the evaluation process with the sourcing team. For
example, the APO/CUPO and the sourcing team must understand that any requirements
of the RFQ must be evaluated on a pass/fail basis and, as a result, any supplier incapable
of meeting the identified requirements will be disqualified as nonresponsive. By
discussing this with the sourcing team, the APO/CUPO can confirm whether certain
identified requirements are actually desirable/needed. With respect to the pricing
evaluation, the APO/CUPO and the sourcing team should determine whether certain
items will include estimated quantities for the purpose of evaluation. Utilizing
estimated quantities will allow certain products to have greater weighting for purposes
of determining the supplier providing the best pricing. For example, if the sourcing
team determines certain items will be purchased with much greater frequency than
other items, weighting the more popular items with a greater quantity will provide a
better analysis of which supplier will provide the best savings based on the State Entity’s
expected buying pattern.

PURCHASING STAGE 4-SOLICITATION PROCESS

4.1. Post RFQ in accordance with GPM guidelines to eQuote and ensure you indicate
Pre-Bid Conference information in the bid description. Attach all documents applicable
as suggested above.

4.2. Address all supplier questions in writing and post answers to questions publicly
as an attached document to the RFQ prior to the closing of the RFQ.

4.3. Make any necessary changes to the RFQ in writing by posting an addendum to
the RFQ prior to the closing of the RFQ. The APO/CUPO may need to extend the RFQ
closing date in the event an addendum is posted near the current RFQ closing date.
Remember no changes may be made to the RFQ after the RFQ has closed.

4.4, Receive all bids through eQuote. eQuote terminates suppliers’ access to the
RFQ once the RFQ closing date and time has expired.
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5.

PURCHASING STAGE 5-EVALUATION PROCESS

As noted in the Georgia Procurement Manual, the RFQ must be awarded to the lowest
priced, responsive and responsible bidder with whom the State Entity is able to reach
agreement as to contract terms. There may be more than one awarded supplier in the
event the State Entity elects to make split awards. Although the majority of the
evaluation may be conducted by the APO/CUPO, the APO/CUPO should utilize its
subject matter experts to determine whether alternate precuts may be considered
equivalent (to the extent the RFQ named certain brands but permitted equivalent
products to be offered).

PURCHASING STAGE 6-AWARD PROCESS

Public notice of the results of the RFQ must be provided as required by the GPM
through the posting of the Notice of Intent to Award (as appropriate) and the Notice of
Award. The Notice of Award should not be issued until the State Entity has either issued
a PO or the State Entity’s contract has been fully executed. Please note the Notice of
Award must be issued within one day of the PO being issued or the contract being
signed (whichever comes first). Any supplier challenges to the process will be resolved
in accordance with the protest process defined by the GPM.

PURCHASING STAGE 7-CONTRACT PROCESS

7.1. Contract will be maintained in accordance with the GPM and posted to the
Agency Contract Index on the Georgia Procurement Registry (as appropriate).

7.2. Contract Kick-off meeting should be conducted with the vendor and
stakeholders to review the terms and conditions, order process and general contract
information. This will help with getting the contract off to a good start. Please review
GPM Chapter 6 “Contract Administration” for additional guidance in contract
management.

7.3. Annual evaluation will be conducted with end users utilizing the Contract
Assessment Report (SPD-CP025). In the event the State Entity desires to renew the
Open State Entity Contract, the renewal shall be exercised in accordance with the terms
of the contract and the applicable provisions of the GPM, which identifies the applicable
forms such as the Notice of Award Amendment Form (SPD-CP024).

Forms are located at: http://doas.ga.gov/StateLocal/SPD/Seven/Pages/Home.aspx.
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APPENDIX A — STATE USE PROCUREMENT LIST

The items listed on the STATEUSE PROCUREMENT LIST (PeopleSoft Contract # GEPS-CERT) can
be viewed and purchased from the Window Shopper catalogue or from Georgia Enterprises for
Products and Services (GEPS). The links for these sites are:

Window Shopper: https://solutions.sciguest.com/apps/Router/Login?OrgName=Georgia

GEPS: http://www.georgiaenterprises.com/

The current State Use Procurement List can be found on the State Purchasing Division web site
at http://doas.ga.gov/StateLocal/SPD/Contracts/Pages/Home.aspx

NIGP Code Product Description Price Product Status
Gloves
2019800003 Yellow Rubber Work Gloves - per case (144 pairs) $91.52 Mandatory
Food Service (Polyethylene) Gloves - per case (10,000
2019800005 gloves) $67.82 Mandatory
2019800002 Leather Work Gloves -XL per case (120 pairs) $189.27 Mandatory
4754161100 Medical Exam Gloves (Small) - per case (1,000 gloves) $69.97 Preferred
Medical Exam Gloves (Medium) - per case (1,000
4754161200 gloves) $69.97 Preferred
4754161300 Medical Exam Gloves (Large) - per case (1,000 gloves) $69.97 Preferred
Medical Exam Gloves (Extra-Large) - per case (1,000
4754161400 gloves) $69.97 Preferred
First Aid Kits ( $50 minimum order for kits and/or replacements items )
3453200001 Plastic 10 Person First Aid Kit $18.65 Mandatory
3453200002 Plastic 25 Person First Aid Kit $21.04 Mandatory
3453200003 Plastic 50 Person First Aid Kit $47.49 Mandatory
3459800016 Metal Standard 10-Unit First Aid Kit $37.95 Mandatory
3459800017 Metal Standard 16-Unit First Aid Kit $53.06 Mandatory
3459800018 Metal Standard 24-Unit First Aid Kit $72.69 Mandatory
3459800019 Metal Standard 36-Unit First Aid Kit $91.24 Mandatory
First Aid Kit Content Replacement ($50 min order)
3459800021 Ammonia Inhalants (10) $2.63 Mandatory
3459800075 Antimicrobial Towelettes 10 $1.80 Mandatory
3459800022 Bandage, 1" x 3" (16) Non Stick Pad $0.87 Mandatory
3459800024 Bandage, 2" Non Stick Pad (4) $3.38 Mandatory
3459800025 Bandage, 4" Non Stick Pad (1) $2.15 Mandatory
3459800028 Bandage, Finger Tip (10) $1.36 Mandatory
3459800027 Bandage, Knuckle Non Stick (8) $1.21 Mandatory
3459800026 Bandage, Triangular approx 40" (1) $1.66 Mandatory
3459800032 Eye Dressing Set (1) $3.69 Mandatory
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Floor Pads (Minimum of 6 cases per order)

3459800033 Eye Wash Solution 1 oz (1) $2.87 Mandatory
3459800034 Gauze 24" x 72" (1) $2.37 Mandatory
3459800035 Gauze, Roll, 4" x 6 yards (1) $1.53 Mandatory
3459800036 Hydrocortisone Cream 1 gram (6) $1.71 Mandatory
3459800037 Insect Treatment Swabs (10) $2.45 Mandatory
3459800039 Medicated Burn Ointment 1/8 (6) $3.43 Mandatory
3459800040 Ointment, Triple Antibiotic 1 gram (10) $2.31 Mandatory
3459800041 Poison Plant Treatment 1/8 oz (6) $3.33 Mandatory
3459800045 Tape, Adhesive, Roll 1"x 2-1/2 yd (2) $2.36 Mandatory
3459800048 Venom Extractor Kit $18.73 Mandatory

Mop Handles & Heads

36598000065 19" Black Stripping Pad (5 per case) $28.35 Mandatory
36598000068 19" Red Buffing Pad (5 per case) $28.35 Mandatory
3659800007S 20" Black Stripping Pad (5 per case) $24.95 Mandatory
3659800007BBL | 20" Blue Luster Burnishing Pad (5 per case) $30.98 Mandatory
3659800007BC 20" Combo Tan Burnishing Pad (5 per case) $24.95 Mandatory
3659800007BP 20" Porko Burnishing Pad (5 per case) $30.02 Mandatory
3659800007B 20" Red Buffing Pad (5 per case) $24.95 Mandatory
3659800007P 20" White Polishing Pad (5 per case) $24.95 Mandatory

Soap Pouches

4859800093 16 oz. Replacement Mopheads (Case of 12) $60.10 Mandatory
4859800094 20 oz Replacement Mopheads (Case of 12) $66.35 Mandatory
4859800095 24 oz Replacement Mopheads (Case of 12) $78.00 Mandatory
4859800096 32 oz Replacement Mopheads (Case of 12) $83.52 Mandatory
4859800087 60" Fiberglass Mop Handles (Case of 12) $166.40 Mandatory

4859800099 Soap Pouches (enriched) Case of 12 $71.35 Mandatory
4859800100 Soap Pouches (antimicrobial) Case of 12 Mandatory
-]

Pallets
5609800002 7 board (40" x 48") $10.67 Mandatory
5609800001 8 board (40" x 40") $10.63 Mandatory
5609800004 Light Weight (40" x 48") $9.47 Mandatory
5609800005 Heavy Weight (40" x 48") Mandatory

Wiping Rags
7359800001 Wiping Rags (5 pound box) $20.65 Mandatory
NIGP Code | Toner Cartridges (Remanufactured) Price Product Status
2079800095 12A6765 - Lexmark $198.76 Mandatory
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2079800162 12A7305 - Lexmark $122.65 Mandatory
2077290435 92298A - HP $28.32 Mandatory
2079800022 92298X - HP $79.43 Mandatory
2079800099 C2610A - HP $41.02 Mandatory
2077980453 C3903A -HP $31.28 Mandatory
2077290456 C3906A - HP $49.99 Mandatory
2077290460 C3909A - HP $92.98 Mandatory
2079800023 C4092A - HP $26.58 Mandatory
2079800024 C4096A - HP $39.35 Mandatory
2079800003 C4127X - HP $38.95 Mandatory
2079800004 C4129X - HP $59.99 Mandatory
2079800090 C4149A - HP $57.42 Mandatory
2079800091 C4150A - HP $86.25 Mandatory
2079800092 C4151A - HP $86.25 Mandatory
2079800093 C4152A - HP $86.25 Mandatory
2079800025 C4182X - HP $63.15 Mandatory
2079800075 C7115A - HP $30.05 Mandatory
2079800076 C8061X - HP $44.27 Mandatory
2079800094 C8543X - HP $129.90 Mandatory
2079800154 C9700A - HP $59.59 Mandatory
2079800155 C9701A - HP $84.33 Mandatory
2079800156 C9702A - HP $84.33 Mandatory
2079800157 C9703A - HP $84.33 Mandatory
2079800086 C9720A - HP $90.24 Mandatory
2079800087 C9721A - HP $90.24 Mandatory
2079800088 C9722A - HP $90.24 Mandatory
2079800089 C9723A - HP $90.24 Mandatory
2079800158 C9730A - HP $140.84 Mandatory
2079800159 C9731A - HP $141.25 Mandatory
2079800160 C9732A - HP $141.25 Mandatory
2079800161 C9733A - HP $141.25 Mandatory
2079800028 FX-3 - Canon $67.85 Mandatory
2079800166 FX-6 -Canon $80.55 Mandatory
2079800167 FX-7 -Canon $85.32 Mandatory
2079800152 Q2612A -HP $36.53 Mandatory
2079800098 Q2613X - HP $34.66 Mandatory
2079800174 Q2624X - HP $70.32 Mandatory
2079800178 Q2670A - HP $93.60 Mandatory
2079800153 Q5942X - HP $74.99 Mandatory
2079800175 Q5949A - HP $40.85 Mandatory
2079800177 Q6511X - HP $77.39 Mandatory

Updated July, 09, 2010
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APPENDIX B- HOW TO PURCHASE

Note that the purchasing card can be used for any of these types of purchases provided
the cardholder complies with all procurement laws and administrative rules.

Mandatory
Statewide Contract
(SwC)

First

No dollar
limit

Not Required

State Entity can buy
from GCI if same
product is offered on
Mandatory SWC

State Entity
Contract
(AC)

Second

Within
State
Entity
DPA

RFP, RFQ (if
Team
Georgia
Marketplace),
or eQuote

State Entity Contract
renewals are allowed
when eligible per terms
of contract and entity
follows renewal
requirements

Mandatory Source
(MAN)

Third

No dollar
limit

Not Required

Certified Products from
GCl and GEPS.
Mandatory GEPS
products are identified
on the State Use
Procurement List
located at:
http://doas.ga.gov/State
Local/SPD/Contracts/P
ages/Home.aspx

Convenience
Statewide Contract
(SWQC)

Fourth (Optional,
choose one from
this level)

No dollar
limit

Not Required

Convenience Statewide
Contracts are available
as a "convenience"
because prices and
contract terms are
finalized.

Preferred Products
through (GEPS)

Fourth (Optional,
choose one from
this level)

Not Required

Prices for certain
products are identified
on the State Use
Procurement List
located at:
http://doas.ga.qov/State
Local/SPD/Contracts/P
ages/Home.aspx

Open Market
(OMP)

Fourth (Optional,
choose one from
this level)

Within
State
Entity
DPA

RFQ (if Team
Georgia
Marketplace)
eQuote, or
RFP

No competition required
if < $5K and can be
used with the P-Card
where applicable. >
$5K requires
competitive bidding

Exempt
(EXM)

No State
Requirements

No dollar
limit

Not Required

Refer to the NIGP
Exempt List located at:
http://doas.ga.gov/State
Local/SPD/Policies/Pag
es/Home.aspx
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Intergovernmental

No dollar

Not Required

Agreement between

(IGA) limit Governmental Entities
Sole Source Unlimited | Post Requires Market
(SS) DPA justification Research
with Notice of
Intent to
Award on
GPR
Sole Brand Within RFQ (if Team | Specific Brand Product
(SB) State Georgia
Entity Marketplace),
DPA eQuote, or
RFP
Multiple Purchase Doesn't alter the Multiple PO Type,
Types responsibility to which may be used for
(MUL) comply with the the following
Order of combinations of
Precedence or purchases on a single
the requirement PO to a single vendor:
to follow the 1. OMP less than
competitive $5,000 + SWC
bidding process 2. OMP less than
for Open Market $5,000 + AC
purchases >= 3. OMP less than
$5,000. $5,000 + MAN
*Note:

AC, OMP, or SB that exceeds State Entity's DPA
must be submitted to SPD for processing by
submitting One-Time Request to Exceed DPA form

(SPD-NIOO06) to SPD for approval.

RFQ = Mandatory to be processed through
the eQuote System with "unlimited" DPA.

RFP = $250K DPA Unless other
designation has been determined by the
Assistant Commissioner of Procurement.
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APPENDIX C - NIGP EXEMPT LIST

(All 019 Category 019 AGRICULTURAL CROPS AND GRAINS INCLUDING FRUITS,
Exempt) MELONS, NUTS, AND VEGETABLES

X 01921 Berry Crops

X 01924 Buckwheat

X 01930 Corn

X 01932 Cotton

X 01941 Fruits, Citrus

X 01942 Fruits, Deciduous Tree

X 01947 Grapes

X 01950 Hops

X 01953 Melons

X 01956 Nuts, Tree

X 01960 Potatoes, Irish

X 01962 Pumpkins

X 01966 Rice

X 01967 Rye

X 01972 Sorghum

X 01973 Soybeans

X 01978 Sugarcane and Sugarbeets

X 01985 Tobacco

X 01990 Vegetables

X 01994 Wheat

(All 040 Category 040 ANIMALS, BIRDS, MARINE LIFE, AND POULTRY, INCLUDING
Exempt) ACCESSORY ITEMS (LIVE)

X 04001 Amphibia (Frogs, Toads, Salamanders and other Cold
Bloodied Vertebrates) Live

X 04002 Animal Carriers

X 04003 Animal Care Supplies (Collars, Clothing, Leashes, etc.)

X 04004 Animal Training Equipment and Supplies

X 04005 Bees

X 04007 Birds

X 04008 Cages/Shelters, Animal and Marine Life (See Class 495 for
Laboratory Type)

X 04009 Cats, All Types (Pets)

X 04010 Cattle, Beef (Breeding Stock)

X 04011 Cattle, Beef (Commercial)

X 04020 Cattle, Dairy

X 04021 Chickens

X 04022 Chicks, Meat Type, Baby

X 04024 Chicks, Meat Type, Starter

X 04026 Cockerels, All Types, Baby

X 04028 Cockerels, All Types, Starter

X 04030 Dogs, All Types

X 04035 Earthworms
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X 04037 Electronic Identification Systems Used for Inventory and
Tracking of Animals

X 04040 Fish, Brood and Fingerling

X 04042 Fish (Not Otherwise Specified)

X 04045 Fish, Tropical

X 04048 Fur Bearing Animals (Not Otherwise Classified)

X 04050 Goats

X 04058 Hibernation Boxes (Butterfly, Ladybug, etc.)

X 04060 Hogs (Breeding Stock)

(All 040 Category 040 ANIMALS, BIRDS, MARINE LIFE, AND POULTRY, INCLUDING
Exempt) ACCESSORY ITEMS (LIVE) CONT.

X 04061 Hogs (Commercial)

X 04070 Horses

X 04071 Houses and Cages, Bird

X 04075 Marine Life (Not Otherwise Specified)

X 04080 Mules and Donkeys

X 04082 Pullets

X 04083 Pullets, Laying Types, Baby

X 04084 Pullets, Laying Types, Starter

X 04085 Rabbits

X 04086 Recycled Animal, Bird, and Marine Life Accessories and
Supplies

X 04087 Rodents (See 495-12,13 for Experimental Types)

X 04088 Reptiles, Live

X 04090 Sheep

X 04091 Specialty Items for Shows and Entertainment (Perches,
Hoods, Hoops, etc.)

X 04092 Toys for Pets

X 04093 Turkeys, Baby

X 04094 Turkeys, Starter

X 04095 Wildlife and Pet Bands, Labels and Tags (Not Electronic)

X 04096 Zoo Animals, All Types

(All 052 Category 052 ART OBJECTS
Exempt)

X 05202 Antiques

X 05208 Ceramic and Glass Objects

X 05212 Collections, Museum Pieces

X 05216 Drawings (Originals)

X 05224 Engravings, Etchings, Lithographs, Serigraphs, and Similar
Reproductions

X 05232 Fabric Designs

X 05240 Masks

X 05248 Mixed Media

X 05256 Paintings (Originals)

X 05264 Photographs

X 05272 Posters and Prints (Not Originals)
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X 05276 Recycled Art Objects
X 05280 Sculptures: Marble, Metal, Plastic, etc.
X 05288 Wood Carvings
Select Exemptions 232 CRAFTS, GENERAL
(Flowers for Teaching Purposes and Commencement
Exercises Only)
X 23227 Dried Flowers and Plants
X 23232 Floral Arrangements, Artificial
X 23235 Floral Supplies: Artificial Flowers, Floral Tape, etc.
Select Exemptions 325 FEED, BEDDING, VITAMINS AND SUPPLEMENTS FOR
ANIMALS (SEE CLASS 875 FOR DRUGS AND
PHARMACEUTICALS FOR ANIMALS)
X 32548 Milk Products
(All 375 Category 375 FOODS: BAKERY PRODUCTS (FRESH)
Exempt)
X 37515 Bread, Rolls, etc. (Including Brown and Serve ltems)
Available on SWC
X 37530 Cakes, Cookies, and Pastries Available on SWC
X 37545 Doughnuts, Fried Pies, Bagels Available on SWC
X 37550 Pastry Shells
X 37554 Pizzas
X 37560 Taco Shells and Tortillas
Select Exemptions 380 FOODS: DAIRY PRODUCTS (FRESH)
X 38010 Butter
X 38015 Cottage Cheese
X 38030 Cream, All Types
X 38033 Desserts, Milk Based (Not Otherwise Classified)
X 38035 Eggnog and Mix
X 38045 Ice Cream
X 38050 Ice Milk
X 38060 Mellorine
X 38075 Milk, All Types
X 38080 Sherbet
X 38085 Toppings, Whipped, Refrigerated
X 38090 Yogurt
(All 390 Category 390 FOODS: PERISHABLE
Exempt)
X 39002 Aquatic Invertebrates (Octopus, Squid, Anemones, Sea
Cucumbers)
X 39005 Casings, Meat, All Types
X 39007 Cheese
X 39015 Dips, Food
X 39021 Eggs, Fresh
X 39028 Fruits, Fresh
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X 39033 Hors d'oeuvres, meat trays, vegetable trays, dessert trays,
etc. for meetings and parties
X 39035 Ice
X 39042 Ice, Dry
X 39049 Meat: Cured, Fresh, and Frozen
X 39056 Oleomargarine
X 39063 Poultry, Dressed
X 39068 Salad Mix, Fresh
X 39069 Salted or Smoked Foods (Fruit, Meat, Seafood, Nuts, etc.)
X 39070 Seafood, Fresh
X 39072 Shellfish, Fresh
X 39075 Shortening (Except Vegetable) and Lard
X 39077 Tamales, Fresh
X 39084 Vegetables, Fresh
X 39091 Water, Drinking (Including Distilled)
Select Exemptions 495 LABORATORY AND FIELD EQUIPMENT AND SUPPLIES:
BIOLOGY, BOTANY, GEOLOGY, MICROBIOLOGY, ZOOLOGY,
ETC.
X 49508 Amphibia For Laboratory Research (Preserved)
X 49512 Animals, Experimental, Not Specially Bred
X 49513 Animals, Experimental, Specially Bred or Selected (e.g.,
Albino Mice and Rats)
X 49525 Biology Specimens and Cultures (Except Microbial)
X 49526 Biology Specimens and Cultures (Including Microbial):
Complete Ecosystems, etc.
X 49530 Botany Specimens
X 49538 Cultures, Microbial (Living Organism)
X 49545 Geology Specimens and Collections
X 49549 Invertebrates and Vertebrates, Preserved
X 49554 Insects for Laboratory Research
X 49578 Reptiles, Preserved
X 49585 Skeletons: Mounted, Unmounted, and Partial
X 49595 Zoology Specimens, Live and Injected
(All 580 Category 580 MUSICAL INSTRUMENTS, ACCESSORIES, AND SUPPLIES
Exempt)
X 58002 Accordions and Accessories
X 58003 Amplified Instruments (Guitars, etc.) and Amplifiers
X 58005 Band and Choral Risers
X 58010 Band Instruments and Accessories
X 58015 Band Room Equipment: Music Cabinets, Stands, etc.
X 58025 Electronic Musical Instruments: Electronic Organs,
Synthesizers, Visualizers, etc.
X 58030 Metronomes and Tuners, Conventional or Electronic
(All 580 Category 580 MUSICAL INSTRUMENTS, ACCESSORIES, AND SUPPLIES
Exempt) CONT.
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X 58034 Music Boxes
X 58035 Music, Sheet and Folio
X 58040 Musical Instrument Repair Parts and Supplies (Except Organ
and Piano)
X 58045 Musical Supplies: Music Holders, Strings, Reeds, etc.
X 58055 Organs (Conventional), Accessories, Parts and Supplies
X 58060 Pianos, Accessories, Tuning Instruments, Parts and Supplies
X 58070 Recycled Musical Instruments, Accessories and Supplies
X 58080 Stringed Instruments, Conventional; and Accessories
X 58085 Tower Chimes, Accessories, Parts, and Supplies
Select Exemptions 595 NURSERY STOCK, EQUIPMENT, AND SUPPLIES
X 59506 Bamboo, Cane, Rattan, Reed, etc.
X 59507 Aquatic Plants
X 59510 Bedding Plants and Cuttings
X 59515 Bulbs and Seeds
X 59526 Edging, Lawn
X 59528 Flowers, Fresh (Flowers for Teaching Purposes,

Commencement Exercises, Banquets, Conferences,
Workshops, etc.)

X 59533 Grates, Guards, and Other Protective Devices For Trees and
Shrubs

X 59535 Groundcovers and Vines

X 59537 Horticultural Specialties incl. Ornamental Floriculture
Products

X 59540 Nursery, Greenhouse and Floral Supplies: Labels, Planters,
Pots, Tags, Trellises, etc.

X 59550 Peat Moss

X 59552 Perennials

X 59555 Plant Foods (Not Fertilizer)

X 59557 Plants, Non-Flowering

X 59558 Plant Shine

X 59559 Plants, Herb

X 59560 Plant Sprayers and Respirators, Plant Propagation Mats,
etc., and Accessories

X 59561 Plants, Indoor

X 59565 Shrubbery, Evergreen

X 59566 Shrubbery, Flowering

X 59570 Trees, Fruit and Nut

59575 Trees, Ornamental and Shade
X 59577 Tropicals
Select Exemptions 715 PUBLICATIONS AND AUDIOVISUAL MATERIALS (PREPARED

MATERIALS ONLY, NOT EQUIPMENT, SUPPLIES, OR
PRODUCTION)

X 71583 Textbooks, Adult Education

X 71584 Textbooks, Special Education

X 71585 Textbooks: Kindergarten thru 5th Grade (Includes Student

and Teacher Editions)
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X 71586 Textbooks: 6th thru 8th Grade (Includes Student and
Teacher Editions)

X 71587 Textbooks: 9th thru 12th Grade (Includes Student and
Teacher Editions)

X 71588 Textbooks: College Level (Includes Student and Teacher
Editions)

X 71590 Video Cassettes, Disks, Tapes, etc. (For Computer and TV,
Prerecorded)

X 71595 Recycled Publications and Audio-Visual Materials

(All 855 Category 855 THEATRICAL EQUIPMENT AND SUPPLIES
Exempt)

X 85515 Costumes and Accessories

X 85522 Curtains, Cycloramas, Draperies, Drops, etc.

X 85530 Dance Floors, Portable

X 85543 Lifts, Orchestra (Theater Pit Area)

X 85544 Lighting and Dimming Controls: Autotransformer Dimmers,
Control Panels, Solid State Thyristor/Triac Dimmers, etc.

X 85546 Lighting Control Systems: Memory and
Computer/Microprocessor Type

X 85548 Lighting Distribution Hardware: Borderlight Cables, Pipe
Battens, Plugging Strips and Boxes, Wall and Floor Pockets,
etc.

X 85550 Lighting Instruments: Border and Cyclorama Striplights,

Follow Spotlights, Floodlights, Special Effects Lighting,
Spotlights, etc.

X 85553 Lighting Systems, Complete
X 85560 Makeup
X 85568 Scenery and Props
X 85570 Sound Effects Equipment
X 85575 Stage Hardware and Supplies: Braces, Canvas, Clamps,
Paints, etc.
X 85577 Standards, Portable; and Ropes (For Theater Lobbies)
X 85580 Stage Rigging and Tracks
X 85581 Stages, Theatre (All Types)
X 85588 Turnstiles, Theater
X 85595 Recycled Theatrical Equipment, Accessories and Supplies
(All 906 Category 906 ARCHITECTURAL SERVICES, PROFESSIONAL
Exempt from
DOAS with
exception to OCGA
50-25 Code (>
$75K, Prequalify) X
X 90602 Acoustics; Noise Abatement - Architectural Services
X 90604 Agricultural Development - Architectural Services
X 90606 Airports (Lighting, Fueling, Navaids) - Architectural Services

Page |72



P-Card Audit Guide

X 90607 Architect Services, Professional

X 90608 Automation; Controls; Instrumentation - Architectural
Services

X 90610 Buildings - Architectural Design

X 90612 Building Sanitation - Architectural Services

X 90614 Cemeteries, Planning and Relocation, Architectural Services

X 90616 Chemical Processing and Storage - Architectural

X 90618 Cold Storage; Refrigeration; Fast Freeze - Architectural

X 90619 Concrete Architectural Services

X 90622 Corrosion Control; Cathodic Protection; Electrolysis -
Architectural

X 90624 Desalinization (Process and Facilities) - Architectural

X 90625 Design Build Services

X 90626 Electronics - Architectural Services

X 90627 Energy Management - Architectural

X 90628 Energy Conservation; New Energy Sources (Solar, etc.) -
Architectural Services

X 90629 Environmental - Architectural

X 90630 Fire Protection - Architectural Services

X 90632 Fisheries; Fish Ladders - Architectural

X 90633 Forensic - Architectural

X 90634 Freight Handling; Materials Handling - Architectural

X 90636 Gas Systems (Propane, Natural, etc.) - Architectural

X 90638 General Construction - Architectural

X 90640 Graphic Design - Architectural

X 90642 Harbors; Jetties; Piers; Ship Terminal Facilities - Architectural

X 90644 Heating; Ventilating; Air Conditioning - Architectural
Services

X 90646 Highways; Streets; Airport Pay-Parking Lots - Architectural

X 90648 Historical Preservation

(All 906 Category 906 ARCHITECTURAL SERVICES, PROFESSIONAL CONT.
Exempt from
DOAS with
exception to OCGA
50-25 Code (>
$75K, Prequalify) X

X 90650 Industrial Processes; Quality Control

X 90652 Interior Design, Space Planning, and Exhibits/Displays

X 90654 Irrigation; Drainage; Flood Control - Architectural

X 90656 Landscape Architecture

X 90657 Land Development and Planning - Architectural

X 90658 Lighting (Interior, Exterior) - Architectural Services

X 90660 Mining and Mineralogy - Architectural

X 90661 Models of Layouts and Buildings to Scale, Architectural

X 90662 Petroleum and Fuel (Storage and Distribution) -
Architectural
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X 90664 Planning, Urban (Community, Regional, Areawide, and
State)
X 90666 Planning, Site (Installation and Project)
X 90668 Power Generation, Transmission, Distribution - Architectural
X 90670 Railroad; Rapid Transit; Monorail - Architectural
X 90672 Recreation Facilities (Parks, Marinas, etc.) - Architectural
Services
X 90674 Recycling Systems - Architectural Design
X 90678 Security Systems; Intruder and Smoke Detection -
Architectural
X 90680 Sewage Collection, Treatment, and Disposal - Architectural
X 90682 Solid Wastes; Disposal Systems - Architectural Services
X 90684 Telephone Systems - Architectural
X 90688 Towers - Architectural Services
X 90690 Tunnels and Subways - Architectural
X 90692 Utilities (Gas, Steam, Electric) - Architectural
X 90693 Video Systems Design - Architectural Services
X 90694 Water Supply, Treatment and Distribution - Architectural
(All 907 Category 907 ARCHITECTURAL AND ENGINEERING
Exempt)
X 90714 Architectural Services, Non-Licensed (Not Otherwise
Classified)
X 90728 Communications Systems; TV; Microwave; Telephone;
Computer
X 90735 Designing Services
X 90738 Drafting Services
X 90740 Engineering Services, Non-Licensed (Not Otherwise
Classified)
X 90742 Geotechnical - Soils
X 90772 Safety Engineering and Accident Studies; OSHA Studies
X 90775 Site Assessment and Site Field Observation
X 90779 Surveying Services (Not Aerial or Research)
X 90783 Testing Services
Select Exemptions 915 COMMUNICATIONS AND MEDIA RELATED SERVICES
X 91502 Advertising (Notice of Bid Solicitation)
X 91503 Advertising/Public Relations
X 91504 Advertising, Outdoor Billboard, etc.
X 91514 Broadcasting Services, Radio
X 91571 Newspaper and Publication Advertising
Select Exemptions 918 CONSULTING SERVICES
X 91804 Accounting/Auditing/Budget Consulting
X 91814 Appraisals Consulting
X 91815 Architectural Consulting
X 91842 Engineering Consulting
X 91874 Legal Consulting
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X 91878 Medical Consulting
Select Exemptions 924 EDUCATIONAL SERVICES
X 92478 Teaching and Instruction Services (Including Elementary and
Secondary Education, Higher Education and Adult
Education)
Select Exemptions 925 ENGINEERING SERVICES, PROFESSIONAL
X 92504 Agricultural Engineering
X 92517 Civil Engineering
X 92533 Engineer Services, Professional
X 92539 Fire Protection Engineering
X 92586 Surveyor Services, Land
Select Exemptions 936 EQUIPMENT MAINTENANCE, RECONDITIONING, AND
REPAIR SERVICES - GENERAL EQUIPMENT
X 93680 Theatrical Equipment Maintenance and Repair
Select Exemptions 946 FINANCIAL SERVICES
X 94612 Actuarial Services and Retirement Planning
X 94615 Appraisal Services, Real Estate
X 94630 Cash/Securities and Bonding Services
X 94631 Certified Public Accountant (CPA) Services
Select Exemptions 948 HEALTH RELATED SERVICES (FOR HUMAN SERVICES SEE
CLASS 952)
X 94864 Nursing Services
X 94874 Professional Medical Services (Including Physicians and All
Specialties)
X 94876 Psychologists/Psychological Services
Select Exemptions 952 HUMAN SERVICES
X 95221 Counseling
Select Exemptions 953 INSURANCE, ALL TYPES

(Not subject to DOAS' authority. DCH handles health
insurance and SPA is authorized to handle flexible benefits
for state employees.)

X 95337 Disability
X 95348 Health/Hospitalization (Including Dental and Visual
Insurance)
X 95363 Life
Select Exemptions 956 LIBRARY SERVICES (SEE CLASS 908 FOR BOOKBINDING,
REBINDING, AND REPAIRING)
X 95635 Internet Database Subscription
X 95640 Magazine Subscriptions
X 95685 Training Material Subscription
Select Exemptions 961 MISCELLANEOUS PROFESSIONAL SERVICES
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X 96147 Law Enforcement Services (Including Process Server
Services)
X 96149 Legal Services, Attorneys
X 96173 Theatrical Services (Including Production, Scenery Design,
Stage, etc.)
X 96185 Utility Services, Electric, Gas, Water (Except when Customer
Choice)
X 96186 Veterinary Services
Select Exemptions 962 MISCELLANEOUS SERVICES
X 96248 Interior Design/Decorator Services
Select Exemptions 963 NON-BIDDABLE MISCELLANEOUS ITEMS
X 96343 Intergovernmental/Inter-Agency Contracts
X 96357 Postage Related Purchases (Incl. Postage Stamps, Pre-Sort
1st Class Inscriptions, Postage by Phone for Meters etc.)
X 96348 Membership Dues
X 96364 Registration Fees
Select Exemptions 971 REAL PROPERTY RENTAL OR LEASE
X 97165 Room Rental for Conferences, Seminars, etc.
Select Exemptions 981 RENTAL OR LEASE OF EQUIPMENT - GENERAL EQUIPMENT
X 98174 Theatrical Equipment and Supplies (Including Costumes)
Rental or Lease
Select Exemptions 998 SALE OF SURPLUS & OBSOLETE ITEMS
X 99844 Food
NIGP Code MULTIPLE NIGP CODES AVAILABLE FOR THE ITEMS BELOW
X Direct Resale through a state Agency/Institution operated
service i.e. bookstore, cafeteria etc.
X Teaching Forms, and Publications for Testing
X Contractors for services only to be provided by Non-Profit
Entities that comply with the requirements of O.C.G.A. 50-
20-1 et seq
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APPENDIX D - EXCEL PIvoT TABLES (EXCEL 2003)

Pivot tables allow you to get different views of data through summarizing in two
dimensions — rows that go down and columns that go across.

Any or all of the columns in the original spreadsheet can be reflected as rows, columns,
or data in the pivot table to present the information you want in summary form. You
are probably already familiar with what one looks like. The table below shows summary
sales data from multiple regions for multiple quarters.

First Quarter Second Quarter Third Quarter e

Quarter

Eastern Region | $10,000 $15,000 $12,000 $13,000

Midwestern $20,000 $30,000 $15,000 $25,000

Region

Southern $30,000 $40,000 $20,000 $10,000

Region

Western $25,000 $15,000 $30,000 $25,000

Region

Totals $85,000.00 $100,000.00 $77,000.00 $73,000.00

Behind all of these summary numbers, lie the thousands of individual transactions that
make up those amounts. Instead of manually adding up all of those individual
transaction amounts, Excel can do it for you.

These exercises are going to use transaction data from the purchasing card and from the
PeopleSoft 19D query.

Some Preliminaries

Make sure your data spreadsheet has no gaps or spaces in it. In order for Excel to
properly identify the data source, all columns must be contiguous. For example, you
cannot create a pivot table from data in columns A-D and columns L-N. The same holds
true for rows — you cannot create a pivot table from data in rows 1-10 and 20-30.

All columns of the spreadsheet with the data must have column headings. Excel will not
recognize a column as being in the range if there is not one.

A good rule of thumb is that if you don’t want to do a calculation on a column, the data
should be formatted as text, even if it is a number. For some Excel formulas to work
correctly, these fields must formatted as text.
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Step #1 — Initiate Pivot Table

The data tab of the workbook has the Nowceias 3“;?@":.“:”.1‘.".’. ez-sk mEle i }

{afats AW R s %) 3 W g | veney wan s, B I 1= ;)
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Step #3 — Define Data Range

Excel will identify the range of data on the spreadsheet. Most of the time, you will want
to include all of the data in the pivot table. However, you can select the range manually
and include just the contiguous columns and rows you want. For example, if you have

data in A1:M2000 but you only want to use
data in A1:D200, you can manually select
that range. However, in our work, it is
highly unlikely that we would want to pivot
just part of the data (or data from multiple
spreadsheets).

Accept the data range that Excel chose by
clicking the Next button.

Where is

Range:

Browese... =
LEY
Finish | FA

Step #4 — Design the Layout of the Pivot Table

This is the step where you determine what your pivot table will look like and how the
data will be summarized. The different areas of a pivot table are:

¢ Data —this is the information that you are trying to summarize, or measure, or

count.

e Page —a “page” is useful if you have a lot of data and you will want to look at only
one main group at a time. For example, if you have 100,000 purchasing card
transactions at 100 Agencies, it might be easier to review one Agency at a time

rather than all Agencies at once.

¢ Row —the “row” determines what columns from the data will be in the left-hand
columns of the table. You can have as many rows as you have columns in the

spreadsheet of data.

e Column -the 1
" ” H
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“Pages™allow- “Cal
the names of the further-segregation: 40 20T0Se]
. f-dat
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the pivot table. # 1 il .
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. . R
shows the relationship ﬂeg‘m
between rows and T
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Click the Layout button.

PivotTable and PivotChart Wizard - Layout I
The column names from the data :l-‘ L3 = Gorstnc you rtTae e
) raqaing the Fisld bUttons on the right
spreadsheet are shown on the rlght.-\ o e B
hand side of the layout box. \\ g
PAGE COLUMM
- =
Any of the spreadsheet columns can ===
also be put in the “Data” area. The - oara
most common use is to present the --ﬂ ¥ |
Fost Date| |Supp. Sta
total of an amount field, such as
transaction or purchase order amount. wh  |[Coe ] camel |
To present the spreadsheet columns as
rows or columns on the pivot table, drag
P » PivotTable and PivotChart Wizard - Layout [ x] I
3nd drOF’)’ the C0|umns to' the ROW or I:l Construct your PivotTable report by
Column” areas of the design screen. gy th fld buttons on the gt
The “Page” area would be a good place —
to put the “Program Name” field in order Lo ] L vec cowm
to be able to filter on one Agency or Exr
. . . . ROW DATA -Cardhold -Supp. Nal nreditu
University at a time. For Compliance
audits, the vendor name from the 19D
query would be a good candidate for a
”Page". Help | Ok I Cancel |

Here, we have put the cardholder name

as the rows going down, the Merchant Category Code as the column, and the sum of the
transaction amounts as the data. The result will be the amount of spend each
cardholder made at merchants assigned to those MCC’s.

Step #5 — Formatting the Numbers

To format the “Sum of Amount” (data) field, double- I
click on the Sum of Amount button in the Data area | sy cefisld:  Amount

(circled in the previous diagram).
Most of the time, you will want to choose the Sum of Cancel |
the amount field. There might be times when you want :

to count the occurrence of the amounts, such as when ¢ Hl—del
you want to know how many transactions for $50.92 Mumber . .. |
we have. This is probably not very useful. However,

you might want to count the number of transaction Dptions >>
numbers or purchase order numbers.

To format the number (e.g. currency with a $ sign), click on the Number... button on the
right side of the dialog box. You can then format the data fields like you would any cells
in Excel.
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Click the OK button in the Format
Cells dialog box when finished. Then,
click the OK button on the PivotTable
Field dialog box.

Click the Finish button on the
Step 3 of 3 dialog box. The pivot
table will be on a new
spreadsheet in the workbook.

Step #6 — Modifying the Pivot Table

The pivot table will display on the
screen. From here, you can remove
columns or rows (MCC column
added in Step #4 has been
removed). You can also drag and
drop other spreadsheet columns to
rows or columns of the pivot table.

In this spreadsheet, the Number
column represents the transaction
number. Drag the Number column
from the Pivot Table Field List
(highlighted and circled in this
screen shot) to the Total column
until the Total column (with the
values) is outlined with a broken
line.

Format Cells [ 2] I

ample
Program Card Mame |

General format cells have no
specific number Format.

Percentage
Fraction
Scientific
Texk
Special

Custom ;I

OK I Cancel

PivotTable and PivotChart Wizard - Step 3 of 3 HE I

Where do you want to put the PivatTable repart?

' Mew worksheet:
" Existing worksheek
S

Click Finish to create your PivotTable report.
Optians. .. Cancel | < Back | Text = ml
1

B Microsoft Excel - Pivot Table Exercise.xls

fle Edt View Insert Format Jools Data  Window  Help

ER £ {
A [ B | C I D I E | F I G N
1 Drop Page Fields Here |
2 —_—
| 3 |Surn of Amount Elobiable X
4 |Cardholder and Cycle |Total PivatTable- | 9 1 | <2 %= | 1| ﬁ' &
| & |Abraham, Marilyn - 2500 $1,674.74]
| 6 | Alexander, Janice - 1000 $546.77
| 7 |Allen, Heather - 5000 $446.26 PivotTable Field List r X
%ﬁ::;‘n:arﬁ&ezrioﬂﬂnm ::g; 23 Drag items ta the PivotTable report
110 | Anderson, Donna - 5000 $596.80 [ Manth N
| 11 |Archie, Herman - 1000 $265.08 ] Amount
| 12 |Argo, Stephanie - 2500 51367 [} 5ump. Hame
13 | Armistad, Audrey - 5000 $3,495.52]
|14 | Aultman, Kevin - 5000 $5,547.56] - Suee. Gty
| 15 | Banks, Tammie - 5000 $3,367 13 ~ [ Supp. State
| 16 |Banks, Tanzy - 5000 §B51.75 ~Emcc
| 17 |Barrs, Holly - 5000 $3.751.21 [ MCC Description
| 18 |BECK, PAMELA SUE - 5000 §2,797.04 5 Sinle Tan Lt
| 19 |Bell, Bedarius - 5000 $309.07
20 |Benjamin, Brandy - 2500 $510.00 T
| 21 | Bannatt, Anita - 5000 $42.00) < [ Wumber —
| 22 |Bing, Alicia M - 10000 $2,130.59] =
23 Blissett, Michelle - 500 $88.06
Eﬁnhannnn, April - 2600 $100.49 :
| 25 |brantley, dianne - 1000 §494 56
| 26 |Branyan, Gail - 5000 $8,899. 49
| 27 Gray, Matasha - 5000 $5.996.91
| 28 |Brinkley, Michelle - 10000 $3,308.79]

Page |81



P-Card Audit Guide

The pivot table now displays the Count
of Number. The table will automatically
display the data fields the way it thinks
you want to. Spreadsheet columns that
are formatted as numbers or currency
will automatically be inserted in the data
area as a “sum” of the amount. Text
fields will automatically be inserted as
“count” of the values. If any of this is not
correct, you can change it.

Now, drag and drop the amount column
into the data area.

You will now see another Sum of
Amount shown as Sum of Amount?2.

This kind of summary doesn’t make
much sense, but you might want to
see the largest transaction amount or
the smallest transaction amount.

To change the summarize option for
the new amount field of the Sum of
Amount2, click on the Field Settings
button on the Pivot Table tool bar
(second button from the right).

If you don’t like the default names,
these can be changed in the
PivotTable Field dialog box.

Change the Max of Amount2 to Largest
Transaction here.

Click on the Max option in the
Summarize by: area. Click on the
Number... button to format the number

as Currency and click OK.

Notice that you can also do “average”
amount and smallest (“min”) amount.

Click OK on the PivotTable Field dialog box.
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The pivot table now displays the
Sum of Amount, the Count Of [ ae et wew ot Foms Do pxa wniow s

Number’ and the Largest iDﬁﬂgléﬁl?fml%E-@Iﬂ'“'|%2"lﬁl|ﬂ@q
] 3 oA T 5y eply with Changes... End Review... - i Aa abl | [
Transaction amount for each [PABABEL DR wisunome e a0 =

E3 Microsoft Excel - Pivot Table Exercise.sxls

cardholder. M- A
A \ B [c [ o T E T F 4
. . . 1 1
To view the details behind any [z
. 3 | Cardholder and Cycle «|Data | Total

number, double-click on the | 4 | Abraham, Marilyn - 2500 Sumn of Amaunt 167474
. . | 5 | Count of Murnber il
number. Excel will display the [ Largest Transsction | $951.67
B L. . . | 7 |Alexander, Janice - 1000 Sum of Amount RAE 7T
individual lines in a new [&] Count of Nurnber 1
9 Largest Transaction $472.08
worksheet. | 10 [Allen, Heather - 5000 Sum of Amount 14528
| 11 | Count of Murnber 3
12 Largest Transaction $308.02
| 13 |Allen, Larry - 2500 Sum of Amount 461.88
| 14 | Count of Murnber ]
15 Largest Transaction §143.38
| 16 | Alligood, Jeffery - 10000 Sum of Amount 105.38
| 17| Count of Mumber ]
18 Largest Transaction $54.77
| 19 | Anderson, Daonna - 5000 Surm of Amount 5988

Pivot Table Extras

Filtering a Pivot Table

Drop-down lists for the row values can be used to filter what is shown on the screen.
Click the drop-down arrow and select the values to show.

To de-select all, click on the - = \ i ~7" LY
(Show All) box to remove all aN{E AV \ )
NG | Sum of Amount Post D
check marks. %\ = iﬂ'ﬂ?ﬂe& SAFE CO = Ef?a‘
[ ACT PROGRAMS 52
Use the scroll bar to scroll |7 Amazan.cam
. . 8 BUMPER TO BUMPER $
through the list. Click one or Ex EEEISEE?ROLJO;?EEDSE\,L CNT GA TCH MILLEDGEVILLE
| 10 GABTH DIST CRTS FISCA Dhdl DELL HIGHER EDUC
more of the check boxes to 11 A ABAC FOX APPLIANCE PARTS OF
. . | 12 G4 ADMIN OFF OF THE C LOWES #00548
show the information for that [ 13 GA ALBANY STATE UNTY MEDIBAG CO
. 5 14 A ALBANY TECH COLLECT MICHAELS #1686
Agency/University and/or 15 | _’i_l R&S INDUSTRIAL SUPPLY 54
H 16 Ok Cancel STAPLES &
Supplier Name and/or any E|_—L DLTMATE OFFICE
18 VAW GRAINGER 938
other row labels. 19)@5&17;;1 A TECH COLnTotal o - - N - - [ER

Click OK when finished.

El - Four-Day Spend 08-08-08.xls

Format IIDDIS Data  wWindow Help
2 -0 - |@E -

anges... End Review...

A
Z

Applying Conditional Formatting

You can apply conditional formatting =~ -5 : Colurn R
to a cell or range of cells just like you
would in a standard spreadsheet.
Click on the cell or the range of cells

you wish to apply conditional oot

formatting to. ird Marme v|Supp. Mame \
SAT co L & 5, co
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On the menu bar, click on Format->Conditional Formatting...

The Cond|t|0na| FOFmattlng d|a|0g Conditional Formatting
box will appear. In Excel 2003, you andition L
ICeH ‘alue Is j Ibatween j I j_] and | j_]

](c:an htave up to three conditional S —— | —— ‘ i
ormats. ' |

add=» | | Delete.. | ok | Cancel |

Click on Cell Value Is in the first drop-
down list. (This is the default value.)
Click on a criteria in the second drop-down list depending on what values you want to
display.

In this example, we are looking for values greater than a certain dollar amount.

Enter a value in the third drop-down list. In this example, we want to filter on all cells
where the value is greater than $5,000.

Click the Format... button to open the Format Cells NN ANV N DA
dialog box. This is the same format box as you O

would see for regular cell formatting. Select how ?}:&:? T:';ﬂ:ha'l-_wl- zlrm ]ﬁ
you want to display the cells. In this example, we e S

want to see the cells highlighted with pink. Click on

the pink box (lower left-hand corner).

Click OK on both the Format Cells dialog box and the
Conditional Formatting dialog box.

]

Cells matching the criteria you entered will be
displayed in pink.

K
$104.04 F104.04
§7.59 #131.17
$54.51 $54.51
§6.45
17.97 §17.97
§11.95 $11.95
1 F13.62) 1021872
$54.95
$50.00
$104.95
$14.20
$10.00
$34.88
$169.90 $163.90
-§3.98

g1 o
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Removing Subtotals

EZMicrosoft Excel - Four-Day Spend 08-08-08.xls

Whenever you pUt in two or more i8] Fle Edt View Insert Format Took  Data  Window Help
spreadsheet columns in the “row” NEEHRES 2RIFRAILBE T o-c- (@ =22 0de anel
. . b L) D% E W Reply with Changes.... End Review... =i Ae abl | [* IrC
area, the pivot table will EEULBEID DY@ ek idees, e ideatl| - P © B
automatically insert totals for e M v & <
: A I B [ c [ D [ 7
row. 1 (
3 |5 Post Date_w| bl
AT [Program Card Name S [Supp. Mame - 5/4/2008 8/5/2008 F
N ENTRAL GA TECH COL AAA LOCK & SAFE CO $33.04
ACT PROGRAMS $2.300.00
Amazon.com
E BUMPER TO BUMPER $84.80 $13.58
19| CNT GATCH MILLEDGEYILLE
1 1 1 10 DMl DELL HIGHER EDUC $21.97
Sometlmes th|S IS helpfu" I FOX APPLIANCE PARTS OF $58.49
H H : 12 LOWES #0548
sometimes it is not, especially when ] s 44500
14 MICHAELS #1686 $154 37
you have tWO or more Spreadsheet E R&S INDUSTRIAL SUPPLY $400.00
16 STAPLES $449.82
columns represented as rows. To 7] ULTIMATE OFFICE 59262
. . . |15 | WAY GRAINGER 935
eliminate the subtotals, double-click 19 [CENTRAL GA TECH CON. Total ¥3 536 2 50 07
. 2? ARTOR, COLLESE T HO SCIE] $367,
on the section that has the
subtotals. In this illustration, that

would be the Card Program Name row section.

PivotTable Field

To remove the subtotals, click on
the “None” radio button and click
OK.

Marne: IF‘ru:ugram Card Mame

Subkotals

Cancel I

=
Counk
Average
Max

Mir
Praoduck

" Automatic

[ show items with no data

Hide |
Advanced. ., |
Layouk, .. |

This looks neater, especially if the
subtotals for the agency are not that
important.

= ou-oads
] et e met Fgmat s Mty
(DSHUECS SR PR IRAB-F w-0-

@ z-8ilnee
(DN dGE D RWeE T

=

e[ F oFoER R
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Sorting a Pivot Table

Sorting a pivot table is not quite the
same as sorting a regular spreadsheet.
The table automatically sorts by the row
values. However, we might want to view
our data in descending order by amount
to see which vendor has the most spend.

To

T |

To sort automatically every time the report is
updated, use the Sark and Top 10 command an
the PivokTable menu.

Sart by

| ~:|  Ascending

" Descending

clic

anywhere
Data=>Sort... on the menu bar. The pivot table
Sort dialog box will appear.

Ed Microsoft Excel - Pivot Table Exercise.xls

@ File Edit ¥ew Insert Format Tools Data  Window Help
DEEHRSEGRIYR IBE I o-a- @z -8
SN A Gl e L7 @ | ¥4 Reply with Changes,.. End Review... -
B5 - fx 595
A B [ ¢ | D | E
1 Drop Page Fields Here |
2
| 3 [Total Spend
4 |[Supp. Name v [Tatal |
| & |1-B00-GOT-JUNK $595.00
| B |A 1 LOCK AND SECURITY $135.99
| 7 |A 1 WACUUM CLEANER $10.00
| 8 |AAND A CHEMICAL PRODU $156.45
| 9 |A LOCKSMITH & SECURITY $233.00
| 10 |A W SMITH SPORTING GO $221.00
| 11 |A-1 FIRE EXTINGUISHE $90.00
| 12 |A-1 LOCK & KEY $96.49
| 13 |A-1 POSTAGE METERS $392.35
| 14 |A-1 SAFE & LOCK CO INC $456.10
| 15 |A-1-U-RENT $285.00
| 16 | AL LOCK & KEY $393.89
| 17 [ACA $2 545.00
| 18 |[ACADEMY SPORTE $39.96
| 19 |Ace Hardware and Rental $19.89
2 %\/ B1 .01

sort the pivot table by the amount, click
in the Total column. Click

Click on the “Value” radio button if not already

ked and choose Descending.

Click OK to return to the pivot table. The values

otk will be sorted in descending order by amount.
= Yalues " Labels The labels automatically sort correctly.
aurmaty
Sort Supp. Mame in ascending order by Takal
Spend
EA Microsoft Excel - Pivot Table Exercise.xls
@ File Edit Wew Insert Format 5 window  Help ,
DEERaald ¥R/ ~F oo @ E
Ql:ltil:ll'ls. » I oK I ':EII'IEE' iﬁ @ L L] Qi % |ﬁ EE @ | ¥ Reply with Changes... End Review?
B7 v A& 25623.00 5
A/ 5 T ¢ T o [ 4
1 Drop Pagfk Fields Here | <
|2 p
3 |Total Spend /
4 |Supp. Name ¥ |Tot
| & [Office Depot 5116 863.51 ~
| 6 |BOB BARKER COMPANY 37 573.95 /
| 7 |wal Mart [§25 52500
[ 8 |GEORGIA CORRECTION! OF 25 30211 ~
| 8 |[FLOWERS FOODS INC §19,755.22 /
| 10 |STAPLES RUSINENNS48045 $18,451.00
| 11 [FULTON PAPER CO §17 90947 \
| 12 [MATL BUSINESS FURNITUR §15 345 47
| 13 |CORP EXPR 800-582-4774 §15,102.04
| 14 [DMI DELL K-12/G0VT §14,260.03
TEAE LT O APE RIS OMP ARLY §1292.08 -
2 T B Y BT AN A SV AP A
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APPENDIX E — EXCEL PIvoT TABLES (EXCEL 2007)

Pivot tables allow you to get different views of data by summarizing in two dimensions —
rows that go down and columns that go across.

Any or all of the columns in the original spreadsheet can be reflected as rows, columns,
or values in the pivot table to present the information you want in summary form. You
are probably already familiar with what one looks like. The table below shows summary
sales data from multiple regions for multiple quarters.

First Second Third Fourth
Quarter Quarter Quarter Quarter
Eastern $10,000 $15,000 $12,000 $13,000
Region
Midwestern | $20,000 $30,000 $15,000 $25,000
Region
Southern $30,000 $40,000 $20,000 $10,000
Region
Western $25,000 $15,000 $30,000 $25,000
Region
Totals $85,000.00 $100,000.00 $77,000.00 $73,000.00

Behind all of these summary numbers, lie the thousands of individual transactions that
make up those amounts. Instead of manually adding up all of those individual
transaction amounts, Excel can do it for you.

These exercises are going to use purchasing card transaction data.

Some Preliminaries

Make sure your data spreadsheet has no gaps or spaces in it. In order for Excel to
properly identify the data source, all columns must be contiguous. For example, you
cannot create a pivot table from data in columns A-D and columns L-N. The same holds
true for rows — you cannot create a pivot table from data in rows 1-10 and 20-30.

All columns of the spreadsheet with the data must have column headings. Excel will not
recognize a column as being in the range if there is not one.

A good rule of thumb is that if you don’t want to do a calculation on a column, the data
should be formatted as text, even if it is a number. For some Excel formulas to work
correctly, these fields must formatted as text.
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Step #1 — Initiate Pivot Table

The examples
transaction data.

used.

Click on

Insert = Pivot Table

that follow use purchasing card

The data tab of the workbook has
the individual transactions. You can click anywhere in
the data range and Excel will identify the data to be

,l_:!%"-ﬂ -e-NEEEHREE )

L%

Home Insert Page Layout Formulas | Data | R
'@FromAccess :,-:E E “ Connections A
= From Web %7 Properties
From Other Existing Refresh L
Eﬁ From Text Sources* | Connections All- 52 Edit Links

Get External Data Connections

@ Security Warning Automatic update of links has been disabled

13 L S | CENTRAL GA TECH COLL
G

) | |

-

Copy data from download spreadsheet, click on cell H3, an7

Program Card Name CH User Name
CENTRAL GA TECH COLL

CENTRAL GATECH COLL

GEMTRAL GATECH COLL
"TECH COLL '

‘IIU'||-|=| w2

Step #2 — Define Data Range & Location of Pivot Table

Excel will identify the range of data on the spreadsheet. Most of the time, you will want

to include all of the data in the pivot table.
However, you can select the range
manually and include just the contiguous
columns and rows you want. For example,
if you have data in A1:M2000 but you only
want to use data in A1:D200, you can
manually select that range. However, in
our work, it is highly unlikely that we
would want to pivot just part of the data
(or data from multiple spreadsheets). \

Click the radio button for either “New
Worksheet” or “Existing Worksheet”. The
default setting is “New Worksheet” and
you will use this option most of the time.
The other option is helpful if you want to

—

|

H92-¢ - DES&2 ka3
Home | Insert I Page Layout Formul
o] P 1 B
12 EH | oal &
PivotTable Table Il Picture Clip Shapes SmartA
- | Art -

Tables Mlustrations

@ Security Warning Automatic update of links has b

13 - # | CEN

“*a from

-
i -

et, o’

“ehe

have multiple pivot tables in a single workbook either on multiple data tabs or on the

same data.
Click OK.
Excel Extra

To place the pivot table on an existing
worksheet, click on the radio button and the
red arrow at the end of the “Location” box.
Navigate to the spreadsheet and the cell
location (not just to the particular
spreadsheet) where you want to put the
table. Hit “Enter” and Excel will take you back
to this dialog box. Click OK.
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Charts
Choose the data that you wank to analyze = lin

+ Select 3 table or range

TablefRange:

£~ Use an external data source

Chonse Conmeskion. . . |

Zonnection name:
* Choose where vou want the PivotTable report ko be placed —————————— == =======~
% Mew Workshest

~ Existing Warksheet

=

Cancel |
v

Location:
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Step #3 — Design the Layout of the Pivot Table

This is the step where you determine what your pivot table will look like and how the
data will be summarized. The different areas of a pivot table are:

¢ Values (fka Data) — this is the information that you are trying to summarize, or

measure, or count.

¢ Report Filters (fka Page) — a “Report Filter” is useful if you have a lot of data and you
will want to look at only one main group at a time. For example, if you have 100,000
purchasing card transactions at 100 Agencies, it might be easier to review one

Agency at a time rather than all Agencies at once.

¢ Row —the “row” determines what columns from the data will be in the left-hand
columns of the table. You can have as many rows as you have columns in the

spreadsheet of data.

e Column - the “column”

determines the names of 1
the columns going across
the pivot table.

“Columns’™
/ go-acrossy|

+ 1
o First-Quarter= Secund-auartem %hird-Ouartem h‘m‘[h-(]uartemgl
Eastern $10,000 $15,000 $12,000 $13,0004"
Region=
Midwestern- $20,000 $30,000 $15,000 $25 000"
. . Regionz % T~
The diagram to the right shows T d
the relationship between rows 1 Datai
) a-l_s-g-x-summary-of—
and columns on the pivot 1 whatisinthe:body-of
the-spreadsheetf
table. What was called
“Pages” in Excel 2003 (see
purple box) is now called

“Report Filters” in Excel 2007.

The pivot table layout screen is slightly different from that in Excel 2003. It
has built-in formatting for Rows. To see the layout screen in the Excel |?
2003 version, click on “Options” in the top left-hand corner.
“Display” tab and the “Classic Pivot Table layout” check box. Then click |2~

OK.

The column names (Pivot Table Field List) from the data
spreadsheet are shown on the right-hand side of the screen.

To put any column in the Row Labels section, click on the
box next to the column name. The rows will appear in the
Row Labels box in the order shown in the list. If you want to
re-arrange them, you can “drag and drop” the fields in that
section into the desired order. You can also drag and drop
field names to any of the areas shown instead of clicking on

Click on the [

PrecATabile Name: | Actir Fickl:

FivatTablel

= Cotions =
PwotTable

By Fiein

@ Secumity Warning 2 Hames [P Tatded

a3 Laout & Fomnat | Totsls Fiters m]mlm

T | |
1 [7 o supandjcolispss buttons.
=z o4
a1 T Show properties i todkins
4 & Tk
5 PIMERTER I e fiekd captions snd fiker drop downs:
1 o ensati o T s s o ok i i
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the box.

Any of the spreadsheet columns can also be put in the “Values” area.

The most

common use is to present the total of an amount field, such as transaction or purchase

order amount.

automatically choose the Sum of that amount for the Value. For
any non-numeric columns, Excel defaults to Count of the rows.

The “Report Filter” area would be a good place to put the
“Program Name” field in order to be able to filter on one Agency
or University at a time. For Compliance audits, the vendor name
from the 19D query would be a good candidate for a “Report

Filter”.

Here, we have put the State Entity name and the vendor name, in
that order, as the rows going down and the sum of the

If Excel detects a numeric column, it should

PivotTable Field List 7

Choose fields to add to report:

[]Begin Date -
[v] Excl. Merchant?

[l Exempt MCC?

[¥ Contract MCC
OLevel 1

[ 5tate Eligible?

OFocus

[ Spend Group

[ Program Card Hame
[ CH User Mame

[OLast 4 Digits

[¥ Amount

[Purchase Date

[JPost Date
transaction amounts as the data. The total in column C will be the 2 comp Sump e
amount of spend for the State Entity (column A) at the merchant D] Comp Supp 5 c
(CO|Umn B). Drag fields between areas below:
“f Report Filter [ column Labels
The Report Filters will be above the pivot table to allow filtering. e
CunhactMC(.: 7
PurchaseDay ~
S———— =
A [ B I C Y
1 |Excl. Merchant? (A1) ] 1 Labels Z Vales
2 |Exempt MCC? (A ] nCard... ¥ Sum of Amount ¥
3 |Purchase Day (all) E wppM... ™
4 |Contract MCC (all) =]
5
6 Sum of Amount
7 |Program Card Name CompsuppName ¥ |Total
8 Z/CENTRAL GATECH COLL DIRECT BRANDS, INC $250.58
B SPENRO INDST9729886161 $126.51 | rLayout Update
10 FACTORY. $67:044/ —rp
?’_\_}B\ s218.87 J !
When using the Report Filters, only data rows
that match ALL of the values selected in the D1 - £]
filters will display. For example, in the - | = |
illustration here, records where the merchant 1 |Excl. Merchant? No
has been identified as “Excluded” from 2 |Exempt MCC? (All) (=]
review, regardless of whether or not the MCC 3 |Purchase Day (Al (=]
is exempt (because of the probable NIGP 4 |Contract MCC (Al1) (=]
code), regardless of the day of the week on »” /\'x
which the purchase was chosen, and
regardless of whether or not there is a
contract merchant with the same MCC. D1 - (‘ fe |
A | B |
As another example, applying the filters as | L |Excl- Merchant? No
shown here will pull all transactions at |2 |ExemptMCC? No
merchants where (1) the merchant has not | 3 |Purchase Day {All) (=]
been excluded and (2) the MCC is not | % |Contract MCC {All) (=]
exempt because of the probable NIGP code. ? f
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Step #4 — Formatting the Numbers

Click on the “Sum of Amount” button in the Values area. When the pop-up menu
appears, click on “Value Field Settings...”.

hant? ¥ | W Move to Report Filter
<7 T [ Move to Row Labels [ oe Fietd settings T
ay i | Source Mame: Amount

B4 Move to Column Label =
CC - Cuskom Mame: ISum of Amount

x Move to Values Summarize by | Show values as

'>< Remove Field > Summarize value field by

Choose the bype of calculation that vou want to use to summarize
) R the data from selected field
bels @5 value Field Settings... |
I ota
ard... ™ Surn of Amount ™ m
Il -

Cancel |

r . ‘/\\\“\._ Mumber Format |
_ _

PAYPAL ~cBS )

Most of the time, you will want to choose the Sum of the amount field. Click on the
“Number Format” button to select the format (e.g. General or Currency).

Click the OK button in the Value Field Settings dialog box when finished.
Excel Extra:

There might be times when you want to count the occurrence of the amounts, such as
when you want to know how many transactions for $50.92 we have. This is probably
not very useful. However, you might want to count the number of transaction numbers
or purchase order numbers.

Step #5 — Modifying the Pivot Table

The pivot table will display on the screen. From here, you can remove columns or rows.
You can also drag and drop other spreadsheet columns to rows or columns of the pivot
table.

Drag the “Credit Limit” field to the Values area. Notice that the default is “Count” of the
Credit Limit. Excel assumes that you want to count the number of rows with something
in this field. In this example, it will count the number of rows for each merchant name.
In this spreadsheet, the Number column represents the transaction number. You can
use a “count” of any field to determine the number of data rows associated with the
field names shown in the Row Labels area.

The pivot table now displays the Count of Credit Limit. The table will automatically
display the data fields the way it thinks you want to. Spreadsheet columns that are
formatted as numbers or currency will automatically be inserted in the data area as a
“sum” of the amount. Text fields will automatically be inserted as “count” of the values.
If any of this is not correct, you can change it. See diagram at top of next page.
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H Row Labels 3 Values

Program Card... ™ Sum of Amount *
Comp Supp M... ™ Countof Cre... *

- .
e .
. . J

Va

rogram Card Name Comp Supp Name

4

Sum of Xt of Credit Limit

CENTRAL GATECH COLL DIRECT BRANDS,

f‘\\ SPEMNRO INDSTI723886:
—— FACTORY

INC

8126.51 1] /
\W'V

3250.58 1

Now, delete the Credit Limit field from the Values area and drag and drop the amount

column into the data area.

You will now see Count of Amount. This kind of summary doesn’t make much sense,
but you might want to see the largest transaction amount or the smallest transaction

amount.

To change the summarize option for the additional amount field, click on the Max
option in the Summarize by: area. Click on the Number... button to format the number

as Currency and click OK.

Notice that you can also do “average” amount and smallest (“min”) amount.

You will now see the Total Amount of spend at the
merchant as well as the largest transaction at the
same merchant.

If you don’t like the default names, these can be
changed in the PivotTable Field dialog box.

Change the Max of Amount to Largest Transaction
here.

T

T TR T TTTT IS TTOT PO
[l Value Field Settings 2|x|

A Source Mame:  Amount

Custom Mame: IMax of Amount

Surimarize by | Show values as

Summarize value field by

Chaose the kype of calculation that you want to use to summarize
the data from selected Field

)umhgr Farmat

Cancel

In this example, the total spend and the largest transaction were the same for Marvair

QPS, so there must have been just one transaction.

However, the total spend at

Sherwin Williams was $377.77 with the largest transaction being $176.69.

To view the details behind I

any number, double-click MARVAIR aps
on the number. Excel will SHERWIN WILLIAMS
display the individual lines P D PARTS
in a new worksheet.
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Pivot Table Extras

Filtering a Pivot Table

Drop-down lists for the Report Filters, Column Labels, and Row Labels areas can be used
to filter what is shown on the screen just like using filters on a standard spreadsheet.
Click the drop-down arrow and select the values to show.

Note that you can also begin a sort on the column from this option.

To apply custom filters, click on the Label Filters bar and then use one of the custom
options. This will save time if you have a long list of values and you know that a lot of
them begin with the same letter or word. For example, you can select “Begins With...”
and enter the letter “B” to see all values in the Row Label that begin with the letter “B”.

[ CEMNTRAL GA TECH COLL

- [w] GA ALBANY TECH COLLEGE
GA ATHENS TECH COLL

o] GA ATLANTA TECH COLL
o] GA AUGLISTA TECH INST

- [of] GA CHATTAHOOCHEE TECH
(o] GA COLUMBUS TECH COLL

4] R
QK I

o

ram Card Mame -7 |Comp Sup,
A Lmisemn vonn
ZJ’ S nual Filters
il SortZto A gram Card Mar

More Sort Options... THEHOME
% | Clear Filtar From “Program Card TUBETAR

. BUMPE’
Label Filters
STAPL

Value Filters

WV | selectan
-] {blank)

RAMND
Amazo
INSIDE
CNT G

Cancel |

| SKILLPA
NATION

|Pro ram Card Name =7 |[Comp Supp Name E.‘
Scfgl | sotAtoz LOWES £00546
£} sortztoa GLOBAL PARTS
Mare Sort Options... THE HOME DEPOT
% | Clear Filter From “Program Card Name” TUBETAPECOM
Label Filters kol & | Clear Filte
Value Filters 3 Equals... ’
Ii| [ (Select Ally s Daoes Mot Equal...
] (blank) . )
CENTRAL GA TECH COLL SOl |
GA ALBANY TECH COLLEGE Does Mot Vith..
3~ GA ATHENS TECH COLL ey ‘
T ANTA TECH COLL “ "
=J | B
| abel Filter (Program Card Name}) ?
Shaow items for which the label
Ibegins with j |B| L
B LUse ? ta represent any single character
Use * to represent any series of characters
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Applying Conditional Formatting

You can apply conditional formatting to a cell or range of cells just like you
would in a standard spreadsheet. Click on the cell or the range of cells you k=

Conationsl Format
. &
o Foematting - a3 Table -

wish to apply conditional formatting to.

On the Home tab, click on Conditional Formatting...

The Conditional Formatting drop-down menu will appear. In Excel 2003, you
can have up to three conditional formats. However, in Excel 2007, you can
apply more than this.

L S

Select Manage Rules... . Conditional | Format  Cell || Insert Del

Formatting - as Table - Styles - kK

= % Highlight Cells Rules »
I 3
L% Top/Bottom Rules

I E Data Bars »
@ Color Scales 3
1@' Mew Rule..
Select “New Rule” B clear Rutes ,

Manage Rules...

0 /‘\\\

Conditional Formatting Rules Manager

(
E Shaw formatting rules for: ﬁ
L

Click on “Format only cells that contain” and [Ef New Rule... T Edit Rule.. ¥ Delete Rule
enter the criteria and desired format in the e ) |Format ?

dialog box. Click OK when finished. In this
example, cells containing a value greater than ¥

$5,000 will be in red font.

Hisabled Options...

New Formatting Rule x|

[ SelectaRule Type:

hiT) » Format all cells based on their values

» Format only cells that contain

» Format only top or bottom ranked values

» Format only values that are above or below average
» Format only unigue or duplicate values

» Use a formula to determine which cells to format

pmp Suj Edit the Rule Description:

PWES #( Format only cells with:
LOBALE
L Hom Cell Value j Igreaherﬂwan j ISDDD @
MBETARI
iti iti IUMPER
To add additional conditional | — PR ‘ omat.._|

formatting, repeat the above |peoce

steps for all desired formatting.  puFiv
M_ - "

Cancel
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Removing Subtotals

Whenever you put in two or more spreadsheet columns in the “row” area, the pivot
table will automatically insert totals for each row.

Sometimes this is helpful, sometimes it is not, especially when you have two or more
spreadsheet columns represented as rows. To eliminate the subtotals, right-click on the
Row Label that has the subtotals. In this illustration, that would be the Program Card
Name row section.

4 |Contract MCC Calibri ~[11 -[A A8 - % 9 F
: - BIEi-O AR
To remove the subtotals, click on the |s —
“ »” 7 |Program Card Name = =
Subtotal...” bar to toggle the subtotals off. o |- CenTRALGATECH COl fowt“
To reinstate the subtotals, simply right-click |[2]| ; :’;mah =
. 10 4] | Refres
on the Row Label name and click on the [ = \
“Subtotal...” bar. 12| Fiter v ER
i Subtotal "Program Card Mame’
| _‘\_ »
L ., ‘-‘—f\_

Sorting a Pivot Table

EREFF P TEERY

Pagelssut  Fomuisi | fats | Review  View  Deveiper

Sorting a pivot table is not quite the same as sorting a regular 3 Womam gy 7y o
spreadsheet. The table automatically sorts by the row values. | el e 2
However, we might want to view data in descending order by amount  pecwssesmmoawns | cseon
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to see which vendor has the most spend. Ao o
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To sort the pivot table by the amount, click anywhere in the Total | fosss® f&0F

. . Sunary

column. Click the Data tab and Sort... on the menu bar. The pivot | _ st

table Sort dialog box will appear. o

Click on the “Smallest to Largest” or “Largest to Smallest” radio -

button.

Click OK to return to the pivot table. The Row Labels will be -

sorted in the selected order by amount. The labels automatically sm.m ! —
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You might also want to sort the pivot table by merchant name. ||smar A
Click anywhere in the merchant name column and click Data = | =&t neeree=
Sort. A different dialog box will display. Click on the radio button |

for either “Ascending” or “Descending” and select the field to sort 7 rusosties.. | o] | concsl |
in the drop-down list. The choices will be the column that you _’—-@4 '
have clicked in on the pivot table and the Value fields (e.g. Sum of

Amount).
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